To register with Sonic Foundry, please follow the steps outlined in the registration wizards upon installation of this product.

Registering your product will provide you with technical support, notification of product updates, and special promotions exclusive only to ACID registered users.

Registration is required within 7 days of installation or your product will expire.

Sonic Foundry product registration helps protect against software copyright infringement and allows us to provide support exclusive to registered users.

If you do not have access to the Internet, registration assistance (in English) is available (Monday through Friday, 8 am-7 pm CST).

- In the US, phone: 1-800-57-SONIC. From outside the US, phone: 001-608-256-5555.
- Fax in the US: 1-608-256-7300. Fax outside the US: 001-608-256-7300.

Sonic Foundry, Inc.
754 Williamson Street
Madison, WI 53703

Sales/Customer Service Only (in North America): 1-800-57-SONIC
Technical Support: 608-256-5555
Fax: 608-256-7300

Sonic Foundry Europe
PO Box 2903
2601 CX Delft
Netherlands
The information contained in this manual is subject to change without notice and does not represent a commitment on the part of Sonic Foundry. The software described in this manual is provided under the terms of a license agreement or non-disclosure agreement. The software license agreement specifies the terms and conditions for its lawful use. No part of this manual may be reproduced or transmitted in any form or by any means for any purpose other than the purchaser's personal use, without written permission from Sonic Foundry, Inc.

Sonic Foundry and ACID are trademarks of Sonic Foundry, Inc. All other products mentioned in this manual are trademarks or registered trademarks of their respective holders.

© 1999 Sonic Foundry, Inc.
# Table of Contents

## Introduction .............................. 7
- Introducing ACID™ .......................... 7
- Reading the Manual .......................... 7
- Getting Started ............................ 8
- Installing ACID ............................. 9
- Starting ACID .............................. 9
- Serial and Activation Numbers ........ 11
- Registration ............................... 12
- Using the Online Help ..................... 13
- Reaching Technical Support ............. 15
- The Sonic Foundry Virtual MIDI Router (VMR) .......... 16

## Quick Start .................... 21
- Welcome to ACID™! ......................... 21
- Finding Loops in the Media Explorer ...... 21
- Arranging Loops in the Track View ...... 23
- Listening to Your Creation .......... 23
# Table of Contents

## ACID Tutorial
- Following the Tutorial .................................................. 25
- Explaining the Paradigm ............................................... 25
- Getting Around in the Main ACID Window ...................... 27
- Using the Toolbar ......................................................... 28
- Navigating in the Media Explorer ............................... 30
- Basic Editing in the Track View ................................. 33
- Editing in the Track List ................................................. 40
- Recording ................................................................. 43
- Adding Effects ............................................................ 47
- Setting Track and Event Properties ............................. 50
- Advanced Track Editing ................................................. 54
- Time Code Synchronization ......................................... 59
- Creating a CD .............................................................. 61

## ACID Reference
- Defining the ACID Program ............................................ 65
- File Menu ................................................................. 65
- Edit Menu ................................................................. 72
- View Menu ............................................................... 79
- Create CD Menu ........................................................ 81
- Options Menu ............................................................ 82
- Help Menu ............................................................... 94
- Shortcut Menus .......................................................... 97
- Keyboard Shortcuts ..................................................... 109
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequently Asked Questions</td>
<td>115</td>
</tr>
<tr>
<td>Index</td>
<td>i</td>
</tr>
</tbody>
</table>
Introducing ACID™

Congratulations: you are now in possession of a revolutionary piece of software for Windows! Once you have experienced Sonic Foundry's ACID, you won't be able to pull yourself away from your computer.

ACID is an amazing new tool that makes the production, arranging and editing of loop-based music easier than ever before. ACID allows you to take the tedious hours of Loop and sample matching out of the music-making equation and opens the doors wide for creativity.

Reading the Manual

In developing ACID, one of our primary goals was to make the interface as easy to use as possible. However, some features may not be immediately apparent, so we hope you take some time to at least page quickly through the manual. That way, you won't miss any of ACID's creative potential.

This manual contains information for all versions of ACID: ACID Pro, ACID Music, and ACID Style. Different versions of the ACID product contain different levels of functionality. ACID Pro contains the highest level of functionality, with ACID Music and Style being "lighter" versions of the Pro product. If a function or operation mentioned in the manual applies only to a particular version (for example, ACID Pro), it will be stated as such. You will also be able to easily recognize these feature differences visually, as we have included the following visual cues for each product:

If you see one of the above icons in this manual, you'll know that the information being discussed is specific to that ACID product.
The manual is separated into five major sections: Introduction, Quick Start, ACID Tutorial, ACID Reference, and Frequently Asked Questions. These sections are briefly explained below.

**Quick Start**

This section contains the basic information for those who like to learn by experience. This section will get you going with the basic features in ACID, but we recommend that you look at the other sections of this manual so as not to miss any important features.

**ACID Tutorial**

This section contains a “how to” approach to using ACID. You’ll probably want to start here to learn everything there is to know about ACID.

**ACID Reference**

This section contains descriptions of each control in ACID. Check here to answer specific questions like, “I wonder what that button does?”.

**Frequently Asked Questions**

This section offers answers to some of the more frequently-asked questions about ACID.

**Getting Started**

Thank you for purchasing ACID, and for your continued support of Sonic Foundry products. You will be required to register your product within 7 days of installation to obtain an activation code that will fully unlock your system. If you do not register and unlock ACID within 7 days, your copy will expire.

**System Requirements**

In order to use ACID, you must have a computer equipped with the following:

- Intel Pentium 133 (for real-time previewing, a Pentium II is recommended)
- Microsoft Windows 9x or Windows NT 4.0 or later
- Windows-compatible sound card
- 800x600 display
- CD-ROM drive
- 32 MB RAM
- 8 MB hard-disk space for program installation (30 MB recommended)
- DirectX Media 6.0 or later
- CD-R or CD-RW drive (required for creating CDs)
- Microsoft Internet Explorer, version 4.0 or later (only required to use online help system)
Installing ACID

Before you install ACID, we recommend that you exit all open programs and temporarily disable any virus protection. After you have done so, follow the steps below to install ACID:

**Note:** ACID requires Microsoft DirectX Media 6.0 to be installed on your computer. If the setup program does not detect DirectX Media 6.0 or higher on your computer, it installs it for you.

1. Insert the ACID CD-ROM into your CD-ROM drive. The ACID installation screen appears (if CD-ROM AutoPlay is enabled).

   If the CD-ROM AutoPlay is disabled on your computer, click on the button and choose Run.

   ![Run Command]

   In the Run window that appears, type the CD-ROM drive's letter and add \setup.exe. Click the OK button to start the installation.

2. Choose the language you want to use for the installation.

3. Click Install Software. The installation process begins.

4. Follow the screen prompts and enter the necessary information when required.
   - Use the button to continue the installation.
   - Use the button to suspend the installation and review previous screen prompts.
   - Use the button to terminate the installation process.

5. At the last screen prompt, click the button to conclude the installation.

Starting ACID

Starting ACID is exactly the same as starting most Windows programs that you may use already. After ACID has been installed on your computer, there are two ways to start the program.
Using the Shortcut

The installation procedure places an icon for ACID on your desktop. This icon is a shortcut to the ACID program located on your hard drive. By double-clicking on this icon, you can start ACID directly from the desktop. The first time you run ACID, a registration dialog appears. In this dialog, you can enter your serial or activation number to begin using ACID. For more information on serial and activation numbers, see the Serial and Activation Numbers section on page 11.

Using the Start Button

The second method also allows you to start ACID from your desktop. This procedure is exactly the same as other Windows-based programs.

1. Click the [Start] button on the task bar. The Start menu appears.
2. From the Start menu, select the Programs option. The Programs list menu appears.
3. From the Programs menu, select Sonic Foundry ACID. A sub-menu appears.
4. From the sub-menu, click on ACID to start the program. The first time you run ACID, a registration dialog appears. In this dialog, you can enter your serial or activation number to begin using ACID. For more information on serial and activation numbers, see the Serial and Activation Numbers section below.
5. Enter either the serial number or the activation number and click Finish to start using ACID. (The serial number is located on the first page of the manual. If you downloaded your copy of ACID, an activation number was provided to you via e-mail.)
Serial and Activation Numbers

The first time you start ACID, the registration window appears. You need to enter either the serial number or the activation code. Either number will start ACID so that you may immediately begin your first project.

The serial number is located on the first page of the manual (or was sent to you via e-mail). This number allows you to run ACID for 7 days. After the 7 days expire, ACID will time out.

If you purchased ACID or would like to try it, you can receive an activation code to continue using the product by registering either online or by telephone. If you are trying the product, your activation code will allow you to use the product for 7 days. After this trial period, ACID will time out.

**Note:** If you have started a project and ACID times out, you will not lose the project. It will be available when you start the program after you have registered your product, and received and entered your activation number.

The activation code you receive when you register is based on the Computer ID number where ACID is loaded. Each computer has a unique number, similar to a license plate. An activation code is created based on that unique number. When you register ACID, Sonic Foundry generates an activation code for you. If you have purchased the product and registered, the activation code you enter in your copy of ACID permanently unlocks your copy; it will not time out. Because the activation code is based on the Computer ID, it is important that you have ACID loaded on the computer where you will be using it.

The Computer ID is automatically detected and provided to you when you install ACID.

For more information on registering and receiving your activation code, see the Registration topic below.
Registration

The Registration dialog that appears when you start ACID allows you to quickly and easily register to get your activation code. You may register via the Sonic Foundry web site or via the telephone.

Registering Online

When you register online, your activation code is sent to your e-mail address within minutes after you complete and submit the online registration form.

To register online, do the following:

1. Select the radio button labeled I don’t have a serial number.
2. Click the Next button.
3. Select the radio button labeled I would like to get an activation code online.
4. Click the Next button. The installation program automatically launches your default web browser and connects you to the Sonic Foundry Online Registration web page.
5. Complete the appropriate information on the registration form, including your serial number. The product name and Computer ID are automatically detected and the fields are filled in for you.
6. Click the Submit Form button.
7. Confirm that your e-mail address is entered correctly. This address is where the activation code will be sent.
8. Submit the form to register. In a few minutes, your activation code is sent to your e-mail address.
9. Copy the activation code from the e-mail message and paste it into the registration field on the ACID Register Online window.
10. Click the Finish button to activate your copy of ACID.
Registering via the Telephone

When you register via telephone, a Customer Service Representative will help you to obtain your activation code.

To register via telephone, do the following:
1. Select the radio button labeled I don’t have a serial number.
2. Click the Next button.
3. Select the radio button labeled I can’t go online to get an activation code.
4. Click the Next button. A new window appears with a field where you will enter the activation code. Your Computer ID number appears above this field.
5. Contact Sonic Foundry at one of the telephone or fax numbers displayed on the Register Over the Phone dialog.
6. Give the Customer Service Representative your Computer ID number. An activation number is generated for you.
7. When the Customer Service Representative gives you the activation number, type it in the field.
8. Click the Finish button to activate your copy of ACID.

Using the Online Help

ACID includes two types of online help: the main online help and What’s This? help (also called “context-sensitive” help). To view the main online help, you need to have Internet Explorer 4.0 or higher loaded on your system (included on the ACID CD-ROM). You can always obtain What’s This? help that is specific to any item in the ACID program. To learn how to find both types of help, see Accessing Help below.

Accessing Help

Both forms of online help are available via the keyboard or the Help menu.
Main Help Window

The main help window is accessed either by choosing Contents and Index from the Help menu or pressing the [F1] key. This window has three tabs which you can use to find the information that you need.

The Contents tab provides a categorized listing of available help topics. Click on the book ( ), then on the topic page ( ) you want information about.

The Index tab provides a complete listing of the help topics available. Use the scroll bar to scroll through the list of available topics or type a word in the text box to quickly locate topics related to the word. Select the topic and click the Display button.

The Search tab allows you to enter a keyword and display all of the topics in the online help that contain the keyword you have entered. Type a keyword in the text box and click on the List Topics button. Select a topic from the list and click the Display button. The topic you selected displays in the information pane on the right.

What’s This? Help

What’s This? help allows you to view pop-up window descriptions for ACID menus, buttons, and dialog boxes. From the Help menu, choose What’s This?, and then click on any ACID item. To use What’s This? help in a dialog box, click on the question mark ( ) in the upper-right corner of the dialog box, and then click on an item.

Help on the Web

Additional ACID help and information is available on the Sonic Foundry web site. From the Help menu, choose Sonic Foundry on the Web to view a listing of web pages pertaining to ACID and Sonic Foundry. If your browser is not already open, ACID automatically starts it for you, and attempts to connect you to the appropriate page on the Sonic Foundry web site via your Internet Service Provider (ISP).
Reaching Technical Support

If you experience problems or have questions while using ACID, there are several ways to get the information that you need from Sonic Foundry: web site support, e-mail support, fax support, and telephone support.

Web Site Support

Visit our web site at www.sonicfoundry.com/support. You will find technical information, reference information, program updates, tips and tricks, and a Frequently Asked Questions (FAQ) archive.

E-mail Support

Send your questions or comments to support@sonicfoundry.com. Our Technical Support department will respond to you within 36 business hours.

Fax Support

Send your questions or comments via fax 24 hours a day at (608) 256-7300. You will receive a response within 36 business hours.

Telephone Support

Our Technical Support representatives are available Monday-Friday from 8 am to 7 pm (CST) at (608) 256-5555.

Before You Call Support

Before you contact our Technical Support department, we ask that you do the following:

- Check to see if your question may be answered in the manual or online help.
- Use a telephone that is near the computer where ACID is installed.
- Make sure you have registered the product. For more information, see Registration on page 12.
The Sonic Foundry Virtual MIDI Router (VMR)

The Sonic Foundry Virtual MIDI Router (VMR) is a software-only driver included with ACID Pro that allows you to control ACID from other MIDI-capable applications and vice versa under Windows 9x and Windows NT without using MIDI hardware.

A MIDI Router simply transfers MIDI data from one port to another. The Sonic Foundry VMR driver does exactly this, but requires no hardware. The driver provides up to four devices for MIDI output and input. Each of the output devices sends all MIDI data to its corresponding input device.

If one application sends MIDI data through the #3 Sonic Foundry MIDI Router output device, another application can receive this MIDI data as input from the #3 Sonic Foundry MIDI Router input device.

Note: The first character of the device name is a device number from 1 to 4. The device number is placed at the beginning of the name for compatibility with sequencer software that tries to display device names in very small places.

The Sonic Foundry VMR can be very useful for synchronizing two MIDI-capable applications. You can trigger ACID from your MIDI sequencer, or you can drive your MIDI sequencer from ACID using SMPTE/MTC. You can accomplish this and more without using MIDI hardware for routing.

Installing the VMR

The Sonic Foundry Virtual MIDI Router (VMR) is included on the ACID Pro CD-ROM. To install the Sonic Foundry VMR, follow the instructions below for the operating system you are running:

Windows 9x

1. From the Start menu, choose the Settings option, followed by the Control Panel option.
2. Double-click on the Add New Hardware icon in the Control Panel window. The Add New Hardware Wizard displays.
3. Click the Next> button. The Add New Hardware Wizard asks if you want Windows to automatically detect your hardware.
4. Click the No radio button.
5. Click the Next> button. The next window allows you to select the type of hardware you want to install.

6. Click on the Sound, video, and game controllers option.

7. Click the Next> button. The next window allows you to select the Manufacturer and model for your hardware.

8. Click the Have Disk... button.

9. Insert the ACID CD-ROM into your CD-ROM drive.

10. In the path list box, type E:\Extras\Virtual MIDI Router\Win9x (where “E” is your CD-ROM drive) and click the OK button.

11. In the Models list, click on the Sonic Foundry Virtual MIDI Router, and click the OK button.

12. Click the Finish button.

13. Restart Windows. When Windows restarts, all programs that support MIDI (including ACID) can use the VMR.

Windows NT

1. From the Start menu, choose the Settings option, followed by the Control Panel option.

2. Double-click on the Multimedia icon in the Control Panel window.

3. Click on the Devices tab, and then click the Add button.

4. Select Unlisted/Updated driver, and click the OK button.

5. Insert the ACID CD into your CD-ROM drive.

6. Click the Browse button and select the drive into which you inserted the CD.

7. Double-click the Extras directory, then the Virtual MIDI Router directory, followed by the WinNT directory.

8. Click the OK button. The driver should now be listed as the Sonic Foundry Virtual MIDI Router.

9. Click once on the driver to select it and click the OK button. Windows installs the driver.

10. When the installation is complete, you are prompted to restart Windows NT to complete the driver installation. Click the Yes button. Once Windows NT has restarted, all programs that support MIDI (including ACID) can use the Virtual MIDI Router.
Configuring the VMR

After installing the Sonic Foundry Virtual MIDI Router (VMR), a new MIDI device is created with the name Sonic Foundry MIDI Router. If you want to install additional devices for MIDI routing (the VMR supports up to four), you must configure the VMR.

Note: When only one routing device is used, the name of the driver is displayed as Sonic Foundry MIDI Router. When multiple ports are used, each port is labeled starting with a number (1 - the number of ports) to identify each connection.

The following procedures describe configuring the number of VMR devices for Windows 9x and Windows NT 4.0. Follow the instructions for the system you have installed:

**Windows 9x**

Note: If you have a large number of MIDI devices in your system, or a multi-port MIDI board such as an eight port MIDI interface, you may have problems installing additional VMR MIDI interface ports. Windows 9x will crash on startup if more than 11 MIDI devices are installed. If you have trouble with MIDI devices causing system errors after installing the VMR, you should reduce the number of ports in use by the VMR, remove the VMR, or reduce the number of MIDI devices in your system.

1. From the **Start** menu, choose the **Settings** option, followed by the **Control Panel** option.
2. Double-click the Multimedia icon in the Control Panel window. The Multimedia Properties window displays.
3. Click the Devices tab.
4. Expand the MIDI Devices and Instruments list by double-clicking it.
5. Click the Sonic Foundry MIDI Router device, followed by the Properties button. The Sonic Foundry MIDI Router Properties window displays.
6. In the General page of the Properties window, click the Settings button. The Configure Sonic Foundry VMR window displays.

7. Select the number of ports you would like to enable from the Ports list.

8. Click OK in all of the windows.

9. Click the OK button again in the Sonic Foundry MIDI Router Properties window.

10. Click the OK button in the Multimedia Properties window.

11. Restart Windows for the new number of devices to take effect.

Windows NT

1. From the Start menu, choose the Settings option, followed by the Control Panel option.

2. Double-click the Multimedia icon in the Control Panel window. The Multimedia Properties window displays.

3. Click the Devices tab.

4. Double-click the MIDI Devices and Instruments icon.

5. Select the Sonic Foundry Virtual MIDI Router from the list of drivers and click the Properties button.

6. Click the Settings button in the Properties window.

7. In the Configure Sonic Foundry VMR window, select the number of ports you would like to enable from the Ports list.

8. Click OK in all of the windows.

9. Restart Windows NT for the settings to take effect.
Welcome to ACID™!

Welcome to Sonic Foundry ACID! This Quick Start section will have you making music faster than you can say “ACID.” Use this section to find out how to start making music right away. If you’re looking for more detailed information, you’ll probably want to skip this section for now (you can always refer to it later!), and move on to the ACID Tutorial section on page 25.

Finding Loops in the Media Explorer

The first thing you have to do to use Loops in a piece of music is to add them to the Track List. To understand why, think of the Track List as your palette: the place where you put the paint colors you are going to use to create your work of art. Once the Loops are in the Track List, you can apply them to your audio masterpiece.

You can add a Track to ACID in a few different ways. The easiest way is to use the Media Explorer at the bottom of the main ACID window. From there, you can browse your local computer or network to find files to open. There are a number of sample Loops on the ACID CD-ROM if you do not have any Loops of your own.
Note: The example pictured above is ACID Pro. Your window may be slightly different, depending on the version of ACID that you have. In addition, each version of ACID includes different sets of loops. The loops shown above may not be included in your version of ACID.

When you click on a file in the Explorer, ACID automatically begins a preview of the Loop at the current tempo. You can stop the preview by pressing the Stop Preview button in the Explorer. You can also completely disable the preview feature by unselecting the Auto Preview checkbox.
Arranging Loops in the Track View

Once you have found a Loop you wish to use, you can add it to the Track View by double-clicking on it, or by dragging it into the Track View. To add Events to the Track, use the Draw tool on the Toolbar and draw across the empty Track.

As you draw, you will notice colored waveform data being displayed. This data is the Loop you have chosen being drawn as if it were being duplicated end-to-end on the Track. The little black indents along the top and bottom of the Event indicate where the Loop repeats itself. Using this technique, you can draw Events anywhere in the Track.

Continue to add more Tracks, and you are already creating your first ACID tune.

Listening to Your Creation

To begin playback from the current cursor position, press the Play button in the Toolbar above the Track View. To play the entire project, regardless of where the cursor is positioned, press the Play All button.

Note: For more information on the Toolbar buttons, refer to the Using the Toolbar section on page 28.
If you want to change the tempo of the project, move the Tempo slider in the lower-left corner of the Track View. This can even be done in real-time as the project is playing.

**Note:** There is time compression and expansion being done on all of the Loops to match the project tempo. While the algorithm is very good, there are still some limitations. You will probably not be able to get a 120 bpm Loop to sound great at 60 bpm. If you are using ACID Pro, there are ways to optimize the stretching by making some adjustments to the Stretch Properties of a Track. These Stretch Properties in ACID Pro are discussed in the ACID Tutorial section on page 25.
ACID Tutorial

Following the Tutorial

This section is devoted to taking a detailed look at the various features of ACID. The topics covered are:

• Explaining the Paradigm
• Getting Around in the Main ACID Window
• Navigating in the Media Explorer
• Basic Editing in the Track View
• Editing the Track List
• Recording
• Adding Effects to Your Project (for ACID Pro and Music only)
• Setting Track and Event Properties
• Advanced Track Editing
• Time Code Synchronization (for ACID Pro only)
• Creating a CD (for ACID Pro and Music only)

Explaining the Paradigm

ACID is a real-time, Loop-based arrangement tool. The power of ACID stems from its ability to take any audio Loop and make it fit into the tempo of a project. You no longer need to lock yourself into a tempo and go through great pains to make your Loops and samples fit that tempo. ACID will take all of your audio and make it match any tempo you choose in real-time! However, there are a few key concepts explained in the following sections that will allow you to best utilize ACID.
Types of Tracks

There are three types of Tracks that you deal with in ACID: Loops, One-Shots and Disk-Based. These types are explained below:

Loops

Loops are small chunks of audio that are designed to create a contiguous beat or pattern when played repeatedly. Loops are usually one to four measures long and are stored completely in RAM for playback.

Loops are the type of Events that you will use most frequently. Because a Loop Track allows Events to be continuously “drawn” across it, the arrangement of Loops is very easy.

One-Shots

One-Shots are RAM-based chunks of audio that are not designed to loop. Things such as cymbal crashes and sound bites could be considered One-Shots. Longer files can be treated as One-Shots if your computer has sufficient memory.

The main difference between a One-Shot and a Loop are that they will not change tempo with the rest of the Loops. One-Shots are also different in the way they can be edited in the Track View. One-Shots will not “draw” across the Track, instead they will be inserted in their entirety as a single block of audio.

Disk-Based

Disk-Based files are usually longer chunks of audio that get played off of hard disk rather than being stored in RAM. Disk-Based files make sense for vocals or any other long audio file that does not loop.

A Disk-Based file can be time stretched with the tempo of the project or not, depending on the properties set in the file. More information on this is contained later in this tutorial.

Not a Multitrack

Any given Loop, One-Shot or Disk-Based file takes up one Track. ACID is not a “multitrack” in the sense that you can put any audio regions you want on a single Track. ACID is designed so that a Track is a time line for a single Event. This makes it easy to place and edit Events with respect to other Events on other Tracks without worrying about whether or not you are editing the right piece of audio.
ACIDizing Files

All of the Loops on the ACID CD-ROM are “ACIDized.” This means that tempo and key information has been stored in them so that ACID has an easier time stretching and pitch-shifting them when they are used together in a project.

You do not need to ACIDize your Loops to use them in ACID. ACID will make good guesses about the tempo of a file and it will be right about 99% of the time. You can also temporarily set the Root Note of the file so it will be transposed to the project’s key. However, if you want to use files in multiple projects you will want to ACIDize them so that these properties will automatically be set whenever you open the file.

Specific information on ACIDizing files is contained in the Setting Track and Event Properties section of this manual.

Getting Around in the Main ACID Window

The main ACID window is divided into three main areas: the Track View, the Track List and a multi-function section that houses the Explorer, Properties, Mixer (in ACID Pro only) and FX (in ACID Pro and Music only) pages. All of these sections can be sized to your preferences by clicking and dragging the divider bars between them.

The Track View is the upper-right section of the main ACID window that contains the arrangement of the audio Events. It is the section where most of your work will be done.

The Track List is the section to the left of the Track View that contains the master controls for each Track. From here, you can adjust the mix, select playback devices, and reorder Tracks, among other things.

The lower half of the ACID window is the multi-function section that contains the Explorer, Properties, Mixer (in ACID Pro only) and FX (in ACID Pro and Music only) pages. These pages allow you to add new loops, add effects to Tracks (in ACID Pro and Music only), adjust the master levels of your playback devices (in ACID Pro only), and set important properties of your Tracks and Events.

The easiest way to learn about a part of the ACID window that you do not know about is to use What’s This? help. Enable What’s This? help by pressing \texttt{Shift} + \texttt{F1}, and then clicking on anything in ACID. A context-sensitive help popup window displays, giving you information about the item on which you clicked.
### Using the Toolbar

The ACID Toolbar, located above the Track List and Track View, is accessible from anywhere within the ACID system. The buttons available on the Toolbar will vary, depending on the version of ACID you have (Pro, Music, or Style), where you are in the system, the actions you are performing, and whether you have customized your Toolbar. The default buttons are explained in the order that they appear on the Toolbar. When you are in the ACID system, you can hold the cursor over a Toolbar button to view the name of the button.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Icon" /></td>
<td>Create a new project</td>
</tr>
<tr>
<td><img src="image2" alt="Icon" /></td>
<td>Open an existing project</td>
</tr>
<tr>
<td><img src="image3" alt="Icon" /></td>
<td>Save the current project</td>
</tr>
<tr>
<td><img src="image4" alt="Icon" /></td>
<td>Display the Publish to ACIDPlanet wizard</td>
</tr>
<tr>
<td><img src="image5" alt="Icon" /></td>
<td>Cut the selected event(s)</td>
</tr>
<tr>
<td><img src="image6" alt="Icon" /></td>
<td>Copy the selected event(s)</td>
</tr>
<tr>
<td><img src="image7" alt="Icon" /></td>
<td>Paste the event(s) from clipboard into current project</td>
</tr>
<tr>
<td><img src="image8" alt="Icon" /></td>
<td>Undo your last action</td>
</tr>
<tr>
<td><img src="image9" alt="Icon" /></td>
<td>Redo your last undone action</td>
</tr>
<tr>
<td><img src="image10" alt="Icon" /></td>
<td>Display the Record dialog</td>
</tr>
<tr>
<td><img src="image11" alt="Icon" /></td>
<td>Activate the Loop Region</td>
</tr>
<tr>
<td><img src="image12" alt="Icon" /></td>
<td>Start playback from beginning of project</td>
</tr>
<tr>
<td><img src="image13" alt="Icon" /></td>
<td>Start playback from current cursor position</td>
</tr>
<tr>
<td><img src="image14" alt="Icon" /></td>
<td>Stop playback and return cursor to starting position</td>
</tr>
<tr>
<td><img src="image15" alt="Icon" /></td>
<td>Stop playback and leave cursor at current position</td>
</tr>
<tr>
<td><img src="image16" alt="Icon" /></td>
<td>Place the cursor at the start of the project</td>
</tr>
<tr>
<td><img src="image17" alt="Icon" /></td>
<td>Place the cursor at the end of the project</td>
</tr>
<tr>
<td><img src="image18" alt="Icon" /></td>
<td>Activate the Draw tool to insert and edit events</td>
</tr>
<tr>
<td><img src="image19" alt="Icon" /></td>
<td>Activate the Select tool to select multiple events</td>
</tr>
<tr>
<td><img src="image20" alt="Icon" /></td>
<td>Activate the Paint tool to insert events across multiple tracks</td>
</tr>
<tr>
<td><img src="image21" alt="Icon" /></td>
<td>Activate the Erase tool to erase events or parts of events</td>
</tr>
<tr>
<td><img src="image22" alt="Icon" /></td>
<td>Activate the Zoom tool to magnify specific areas of the Track View</td>
</tr>
<tr>
<td><img src="image23" alt="Icon" /></td>
<td>Activate the Envelope tool to edit Envelopes (in ACID Pro and Music only)</td>
</tr>
<tr>
<td><img src="image24" alt="Icon" /></td>
<td>Display the Create CD dialog (in ACID Pro and Music only)</td>
</tr>
<tr>
<td><img src="image25" alt="Icon" /></td>
<td>Activate What’s This? help to obtain information about a specific option, menu, or part of the ACID window</td>
</tr>
<tr>
<td><img src="image26" alt="Icon" /></td>
<td>Access the Loop Library page on the Sonic Foundry website to get information on currently-available and upcoming libraries</td>
</tr>
</tbody>
</table>
Customizing the Toolbar

The ACID Toolbar is fully customizable. To add or remove buttons from the Toolbar, double-click on a blank space between two buttons or at the end of the Toolbar. The Customize Toolbar window displays. The column on the left lists all of the available buttons that are not currently displayed on the Toolbar. The column on the right lists all of the buttons that are displayed on the Toolbar.

If you customize your Toolbar, and then decide that you want the Toolbar to be returned to its original configuration, click the Reset button.

Adding a Button

To add a button to the Toolbar, follow these steps:

1. Select the button you want to add from the Available toolbar buttons list on the left.
2. Click the Add button. The new button appears in the Current toolbar buttons list on the right.

You can also double-click the button in the Available toolbar buttons list to add it to the Toolbar. To place buttons into logical groups, you can add a Separator from the Available toolbar buttons list between buttons.

Removing a Button

To remove a button from the Toolbar, follow these steps:

1. Select the button you want to remove from the Current toolbar buttons list on the right.
2. Click the Remove button. The button is removed from the Current toolbar buttons list and appears in the Available toolbar buttons list, from which you can add it to the Toolbar again later, if desired.

You may also double-click on the button in the Current toolbar buttons list to remove it.
Reordering the Buttons

To reorder the buttons on the Toolbar, follow these steps:
1. Select the button you want to move in the Current toolbar buttons list.
2. Click the Move Up or Move Down button.

Note: You do not have to go into the Customize Toolbar dialog to reorder or delete buttons. If you press the Shift key and then click on a button on the Toolbar, you can pick it up and move it to a different location. If you drop the button on a part of the ACID window that is not the Toolbar, the button is deleted.

Navigating in the Media Explorer

Using the Media Explorer is the easiest way to find and preview Loops and other audio from within ACID. To access the Media Explorer, click on the Explorer tab at the bottom of the ACID window.

Note: The example pictured above is ACID Pro. Your window may be slightly different, depending on the version of ACID that you have. In addition, each version of ACID includes different sets of loops. The loops shown above may not be included in your version of ACID.
Basic Navigation

The Media Explorer is designed to work in much the same way as the Windows Explorer. On the left side is a tree view of all of the drives and folders that are available to you. On the right side, you will see a listing of all of the files contained in a selected folder that are valid ACID media. File types that can be selected from the Media Explorer are Wave, AIFF and ACID Projects.

By default, the left side of the Media Explorer displays Windows My Computer and Network Neighborhood, as well as any Library Folders that have been defined. To browse through these items, click on the plus sign next to the icons. You may also double-click on the icon itself.

As you expand folders, you will notice that the contents of the folder are displayed on the right side of the Media Explorer window. At any time, you may double-click on a file on the right and add it to your ACID project.

Note: You may also add files by dragging them into the Track View. Using this method, you can add multiple files at once.

To collapse any part of the folder tree on the left side of the Media Explorer, click on the minus sign next to the icon. You may also double-click on the icon itself and it will collapse.

Creating Libraries

A Library Folder is a quick way of accessing folders that you use frequently in ACID. Any defined Library Folders appear at the top, left side of the Media Explorer as file cabinets. These Library Folders behave exactly like any other drive, so browsing through them is the same.

To create a Library Folder from a folder, right click on the folder. Choose the Add as Library Folder option from the shortcut menu. A new file cabinet icon appears at the top of the list with the name of the folder and its path.

To remove a Library Folder, right click on its icon. Choose the Remove Library Folder option from the shortcut menu. The icon is removed from the list.
Previewing Loops

What makes the Media Explorer such a powerful tool is its ability to preview Loops before you open them. The previewing capability saves you time by eliminating the trial-and-error approach to picking Loops.

The Loop previewing can be manual or automatic. To enable Auto Preview mode, check the Auto Preview checkbox in the bottom right corner of the Media Explorer window. If this checkbox is selected, whenever you click on a file in the Media Explorer, it will begin to preview automatically. When this checkbox is unselected, you must press the Play button next to it to begin previewing the selected Loop. To stop the playback of a Loop, press the Stop button next to the Play button. The volume of the Loop is adjusted with the Volume fader to the left of the Play button.

Previewing Loops can also be done while the current ACID project is playing. This is an invaluable feature when deciding what Loops work well together. To do this, follow the steps below:

1. Start the playback of the project.
2. Select any Loop to preview. The selected Loop plays in sync with the rest of project.
3. If you like the Loop, double-click on it to add it to the project. If you do not like the Loop, simply choose another one to preview.

---

**Note:** Very small files that have not been ACIDized may not preview correctly. If ACID does not guess the file's tempo correctly, it must be ACIDized first for proper results.
Basic Editing in the Track View

The Track View is the main part of the ACID window where you will be doing most of your work. Each Track should be thought of as a timeline for each Event. The Track View is pictured below.
Using the Track View

The Track View is made of several different elements, each with their own intended function. The bulk of the window is made up of actual Track space. This area contains the drawn Events on each Track. However, there are other aspects of the Track View to become aware of.

Along the top of the Track View is the Beat Ruler. This timeline allows you to place Events in reference to the musical time of bars and beats. This timeline is fixed and will not update when you change the tempo. This allows the Events in the Tracks to maintain their size when the tempo is adjusted.

Along the bottom of the Track View is the Time Ruler. This timeline can show real time in many different formats. To change the format of the display, right-click on the timeline and choose an option from the shortcut menu. For more information on these timeline options, see Time Ruler Format on page 83. This timeline changes with tempo, since the number of bars and beats per second of real-time changes with tempo.

Below the Time Ruler is the horizontal scroll bar. Clicking on and dragging this scroll bar pans the view of the project left or right. The ends of this scroll bar also function as zoom controls. By clicking on and dragging the very edges of the scroll bar, you can zoom the project in and out to various levels of magnification.

Note: Double-clicking on the horizontal scroll bar zooms the project out so that the entire project, from beginning to end, is displayed.

To the right of the Time Ruler are the dedicated Time Zoom controls. Clicking on the larger of the two magnifying glass icons increases the magnification around the cursor position. Clicking on the smaller of the two icons decreases the magnification around the cursor position.

On the right side of Track View is the vertical scroll bar. Clicking on and dragging this scroll bar pans the view of the project up and down.

Note: Double-clicking on the vertical scroll bar zooms the project out so that as many of the Tracks in the project, from top to bottom, are displayed as possible.
Directly below the vertical scroll bar are the dedicated Track Height Zoom controls. Clicking on the larger of the two magnifying glass icons increases the level magnification of the project. This allows you to better see low level material in the Tracks at the cost of seeing fewer Tracks on the screen at one time. To decrease the level magnification, press the smaller of the two icons.

**Adding Events to a Track**

Once you have created a Track by adding a file from the Media Explorer, you will want to tell ACID when to play the Event. The Draw tool on the Toolbar facilitates this.

The Draw tool is the tool that you will probably use most often. It allows you to accomplish most of the functions in the Track View. By clicking on the empty Track and dragging the Draw tool to the right, an Event is added. The longer you drag, the more times the Loop is repeated. Repetitions in the Loop are denoted by the black indents in the top and bottom borders of the Event.

Using the Draw tool, you can continue to “draw” Events in your Tracks anywhere you like; in this way, you build a project by simply drawing the different parts.

**Playback Navigation**

After you add some Events, you will undoubtedly want to hear them. To play the project from the beginning at any time, press the Play All button on the Toolbar. Pressing this button starts playback of the project from the very beginning of the project, no matter where the current cursor position is.

To play from a specific point in the project, select the Draw tool on the Toolbar, and then click anywhere on the Track View. Next, press the Play button on the Toolbar. The cursor moves to that location and begins playing.

To stop playback, press the Stop button. The Stop button differs from the Pause button in that it stops playback and bring the cursor back to its starting position. The Pause button stops playback, but leaves the cursor at its current position.
Other buttons on the Toolbar are provided for playback navigation as well. The Go to Start \( \rightarrow \) and Go to End \( \rightarrow \) buttons bring the cursor back to the start and end of the project, respectively. The Previous Marker \( \leftarrow \) and Next Marker \( \rightarrow \) buttons move the cursor to Markers that are defined in the project.

**Note:** The Previous Marker and Next Marker buttons do not appear on the Toolbar by default. You can customize your Toolbar by adding them to it. For more information, see Customizing the Toolbar on page 29.

**Looped Playback**

Looping the playback of your ACID project is useful when you want to concentrate on a certain section. The region in which playback loops is defined by the Loop Region. To make the playback loop within the Loop Region, you must enable looped playback mode by either clicking the Play Looped button on the Toolbar, or by right-clicking on the Loop Region and choosing Play Looped from the shortcut menu.

To move the Loop Region as a single entity, click on and drag the inside bar between the endpoints of the Loop Region. Moving the Loop Region in this way maintains its length. To edit the length of the Loop Region, click on and drag either of the endpoints.

**Note:** Double-clicking on the inside colored bar of the Loop Region forces the endpoints to the extents of the Track View window.

Several shortcuts exist to manipulate the location of the Loop Region. Pressing the \( \text{Ctrl} \) key while clicking moves the start of the Loop Region to where you click. Pressing \( \text{Ctrl} + \text{Shift} \) while clicking moves the end of the Loop Region to the location where you click, unless you click before the current start of the Loop Region. In this case, the start of the Loop Region moves to the point where you clicked.
Changing Tempo and Key

A project can be played at any tempo or key. To adjust these parameters, look at the controls to the left of the Time Ruler. The long slider is the Tempo slider. The tuning fork icon is the Key control.

To adjust the tempo, click on and drag the Tempo slider. Dragging the slider to the left slows the tempo, while dragging it to the right speeds the tempo.

To move the slider in finer increments, click on the small arrow buttons to the right of the Tempo slider. These buttons will move the tempo by fractions of a BPM.

An exact tempo value may also be entered directly by double clicking on the Tempo text. The text will turn into an edit control into which you may type a tempo. Press the Enter key on the keyboard when you are finished.
The key of a project can be adjusted using the Key control. Each Loop that has a specified Root Note in its properties will be transposed to the key indicated by the Key control. To change the key, click on the Key control and choose a new key from the list. This feature makes it possible to use Loops that are in different keys in the same project.

For example, if you have three Loops that have Root Notes of A, B and C, and your Key control is set to D, the loops will be pitch-shifted by 5, 3 and 2 semitones, respectively.

---

**Note:** The Tempo slider and Key control can both be adjusted in real-time as the project is played back.

---

**Editing Events**

There are many things that you will want to do with an Event after you draw it. The Draw tool can also be used to do this basic editing to Events that you have drawn.

Many times you will want to move an Event after creating it. To do this, click on the Event you wish to move and drag it to the new location. Multiple Events can be moved at the same time by clicking on the first Event to select it and then holding down the Ctrl key and clicking on the other Events that you wish to move. With all of the Events selected, you may now click on any one of the Events and drag them all to a new location.

Changing the length of an Event is also a common task. This can be accomplished by placing the mouse over the very edge of the Event. The mouse cursor changes into a bi-directional arrow, indicating that it can be dragged in either direction. Now, click on and drag the edge as far as you want to.

To delete an Event from a Track, click on the Event and press the Delete key on your keyboard.

**Cutting, Copying and Pasting Events**

Just like a word processor for audio, ACID will allow you to cut Events, copy Events and paste them into new places.

To cut, select the Event or Events you wish to remove and press Ctrl+X on your keyboard. This command removes the selected Events and places them onto the ACID clipboard. You may now paste the cut Events anywhere in the ACID project by placing the cursor where you would like them to go and pressing Ctrl+V on the keyboard to paste them.
An important thing to remember is that Events will always be pasted back in their own Tracks. There is no way to paste a group of Events from one set of Tracks to another.

Also, pasted Events will sit on top of other Events in the Track if they overlap. To make space for pasted Events rather than pasting them on top of existing Events, press Ctrl+Shift+V or choose Paste Insert from the Edit menu. This command pastes the Events at the current cursor position, but moves any existing Events over to make room for them.

If you want to copy a group of Events rather than cut them, select the Events and press Ctrl+C on your keyboard. All of the selected Events are copied to the ACID clipboard and are available to paste back into the ACID project.

---

**Note:** You may also copy a group of selected Events by holding down the Ctrl key, clicking on a selected Event, and dragging it to a new location.
Editing in the Track List

The Track List is located to the left of the Track View. This section contains controls for each Track, including Mute, Solo, Device Selection, and Volume, to name a few.

Note: The example pictured above is ACID Pro. Your window may be slightly different, depending on the version of ACID that you have.
Adjusting the Mix

Each Track has its own master volume level, pan, and FX send (FX found in ACID Pro only) controls. All of these controls are accessed with the multi-purpose fader.

To select a function for the fader to control, place your mouse over the fader label (it should read “Vol: <some number>”) and click. A drop-down list appears with choices for Vol (short for Volume), Pan, and FX for as many effects as you have installed (FX found in ACID Pro only). Once you have selected one of the choices, moving the fader to the right of the drop-down list adjusts the value of that control.

Volume controls how loud the Track is in the mix. A value of 0 dB means that the Track will be playing at its normal volume with no boost or cut from ACID. Negative numbers cut the volume, while positive numbers boost the volume. Double-clicking on the fader sets the value back to 0dB.

Note: When adjusting the mix of your Tracks, remember to look at the meters next to the Media Explorer. Because you are adding the volumes of all of the Tracks together, it is easy to clip the audio output. Make sure that the meters never have the red Clip indication lit while playing.

Pan controls where the Track is placed in the stereo field. Moving the fader to the left places the Track in the left speaker more than the right, while moving the fader to the right places the Track in the right speaker. Double-clicking on the fader sets the value back to the middle.

The FX faders (in ACID Pro only) control the level of the Track into each of the DirectX plug-ins that you have selected. The faders function in the same way as the Volume fader. Using the effects is explained in more detail in the Adding Effects section on page 47.

Note: If multiple Tracks are selected, the faders all move together as a group.
Selecting Playback Devices

Each Track can be played through any device (sound card) that is installed in your computer. To choose a playback device, click on the Playback Device selector button. This list shows all of the available playback devices that are installed in your computer. Choose one from the list to send the current Track to that device.

The playback device of multiple Tracks can be selected simultaneously. Select a Track by clicking on its icon, then, while holding the Shift key on your keyboard, click on another Track in the Track List. All of the Tracks between your clicks are selected. Change the playback device for one of the selected Tracks, and they all change. Using the Ctrl key on your keyboard in this manner allows you to select multiple, non-adjacent Tracks.

Mutes and Solos

Often, it is necessary to listen to individual Tracks or to NOT listen to certain Tracks while you are playing a project. These functions are handled by the Mute and Solo buttons in the Track List.

Pressing the Mute button on any Track keeps that Track from being played in the mix. To unmute a Track, press the Mute button again.

Note: By selecting multiple Tracks, the Mute and Solo buttons are activated on all of the Tracks simultaneously.

The inverse of the Mute button is the Solo button. Pressing the Solo button on a Track mutes all of the other Tracks. Pressing the Solo button on other Tracks unmutes them, such that groups of Tracks can be soloed. To un-solo Tracks, press the Solo button again.

Note: You can change the behavior of the Solo button so that pressing it only solos that Track, as opposed to adding it to the solo group. To enable this behavior, press the Ctrl key on your keyboard when you click on a Solo button.
Reordering Tracks

Tracks can be moved around to create logical groupings at any time during a project’s creation. To move a Track, click on its icon and drag it to a new location. The new location is indicated by the highlighted line separating the Tracks.

Multiple Tracks can be moved at one time by first selecting all of the Tracks, and then following the procedure stated above. To select multiple Tracks, use the Shift or Ctrl keys on your keyboard while clicking on the Track icons.

Recording

ACID can record an audio input from a sound card while playing the current ACID project. This feature allows you to create your own Loops and Disk-Based Tracks.

**Note:** To use this feature, you must have a sound card capable of simultaneous play and record. Check with your sound card manufacturer to confirm that your card is capable of this feature. Alternatively, you could use two separate sound cards.

Recording Basics

To open the Record dialog, press the Record button on the Toolbar. From this dialog, you can select the device to record from, the attributes of the recorded file, and where on your hard drive the file will be recorded.
Note: The Record dialog pictured on the previous page is found in ACID Pro. Your Record dialog may be slightly different, depending on the version of ACID that you have.

When you are ready to record, press the Start button. When you are finished, press the button again (it will have turned into Stop). The recording is added as a new Track at the end of your project.

If the recording is smaller than the Play files from disk if bigger than threshold you have set on the General page in the Preferences dialog (accessible from the Options menu by choosing Preferences), it is stored in RAM. Otherwise, the Track is Disk-Based. You may also choose whether or not the new Track changes tempo with the project. To enable this feature, select the Make new track follow project tempo checkbox prior to recording.

If Play Looped is turned on in the ACID project, playback loops as you are recording. The recording that you make is recorded as a single Track. If you have ACID Pro, you can edit the recorded Track to include only the take you wish to keep using the Loop Region and the Mix to New Track option on the Edit menu.

To accomplish this, follow these steps:

1. Solo the new Track.
2. Position the Loop Region around the take you wish to keep.
3. From the Edit menu, choose Mix to New Track. The contents of the Loop Region are saved to a new file, and a new Loop Track is created.

If you are going to use this method of creating Loops, it is recommended that you record without the Make new track follow project tempo option enabled on the Record dialog. This preserves the quality of the recorded audio and make the time stretching sound better.

Record From...

The Record from options determine from what point your recording commences. By default, the Start of project option is selected, and recording begins at the beginning of the current ACID project. You can change the start position by selecting the Position radio button, and then typing a new project position (in measures and beats format) into the field to the right.
Recording Attributes

There are three attributes that make up a recorded digital signal: Sample size, number of channels, and sample rate.

Sample size controls the resolution of the recorded signal. If you have ACID Music or Style, the only sample size available to you for recording is 16-bit. If you have ACID Pro, you can select your desired sample size for recording from the Record dialog. To do so, click the Sample size field and select the appropriate setting from the drop-down menu. CD-quality audio is recorded at 16-bits per sample and most sound cards can record at this resolution. Some newer and higher-end sound cards can record 20 and 24-bit audio.

**Note:** If your sound card can record 20-bit audio and you wish to use this resolution, choose 24-bit in the Record dialog.

There are two common and accepted ways to send 24-bit data to audio hardware. The first way is to send each 24-bit sample of data “packed” into a 24-bit piece. When recording, this method can be more efficient and save hard drive space. The other method is to send each 24-bit sample of data in a 32-bit “unpacked” piece. If you are recording, this type of data will take up more hard drive space and may or may not be more efficient, depending on the sound card.

The sound quality of these two methods is identical. Most sound cards support both, but a few cards only support one or the other. If you receive error messages while trying to play or record at 24-bit with a certain sound card, try switching to the other 24-bit method.

Channels, in the Record dialog, simply controls whether the recorded signal will be mono (one channel) or stereo (two channels). If you are recording mono, you will need to use the left channel of your sound card for input.

The sample rate attribute determines the sample rate at which you record and play. The only sample rate available in ACID Music and Style is 44,100 Hz. If you have ACID Pro, you can change the sample rate from the Preferences Audio page (accessible from the Options menu by choosing Preferences). To do so, click the Playback and record sample rate field and select the appropriate setting from the drop-down menu.
Monitoring Levels

ACID provides a responsive meter in the Record dialog to monitor the incoming signal level of the chosen recording device. It is important that you record with as high of a signal as possible without clipping.

Clipping occurs when the incoming signal is too high to represent as a digital value. The result is a nasty distortion in the recording. A clip is indicated with a red Clip warning at the top of the meters.

The peak signal level is displayed at the top of the meters in decibels. Remember that a reading of 0 dB is as high as you can possibly go with a digital signal.

To clear this reading at any time, click on the numbers. The numbers reset and a new peak reading is calculated.

Monitoring Audio

It is important to note that the Monitor check box in the lower left corner of the Record dialog is only for level monitoring. Monitoring or listening to the incoming audio is a completely different story and can be a point of confusion.

The fail-safe way to monitor your incoming audio while you record is to listen to the source before it goes into the sound card.

For example, let's say you are recording a guitar and you have the microphone plugged into a mixer which is then hooked up to your sound card. You will want to listen to the incoming guitar signal through the monitor outputs of the mixer rather than the outputs of the sound card. In this way, you will always hear the recorded signal, regardless of the capabilities of your sound card, and the timing of the recording with respect to the existing Tracks will be more accurate.

The downside to this method is that you will not be hearing the audio in a post-sound card method prior to the recording actually being made. Therefore, the quality of the sound you hear and of the sound that is really recorded will be slightly different depending on the hardware you are using.

Some sound cards automatically route the incoming audio signal to the outputs of the card during record. This method is a better way to monitor the audio, since you will hear it after the analog to digital conversion. However, most cards that support this feature do not support it while also playing back audio at the same time. This method makes simultaneous recording and playback impossible.

For more detailed information, check the documentation for your audio hardware to verify its capabilities prior to recording with ACID.
Adding Effects

ACID Pro supports all DirectX Audio plug-ins. If you have ACID Pro, this means that all of the DirectX Audio plug-ins available from Sonic Foundry or any other company will be available to use in your ACID project.

ACID Music supports Sonic Foundry’s ExpressFX DirectX Audio plug-ins. If you have ACID Music, this means that you can use ExpressFX 1 or ExpressFX 2 in your ACID project.

Adding these effects to Tracks in your ACID project is a three-step process. You must first select the plug-in you wish to use, then route the appropriate Track or Tracks to the effect, and finally, adjust the parameters of the effect to taste.

Selecting Effects

Plug-ins are selected from the FX page(s) at the bottom right corner of the ACID window. ACID Pro starts by displaying two available FX pages; however, up to eight FX pages can be added in ACID Pro by changing the Number of effects pages to display control on the General page of Preferences. Only one FX page is available in ACID Music.

Click on the FX tab to display the FX page. From the Plug-In drop-down list, you can select any of the DirectX plug-ins that are installed on your computer. Once you have selected an effect, its property information is displayed on the right side of the FX page.

Routing Tracks to the Effect

Assigning or sending a Track to an effect is accomplished differently in ACID Pro and ACID Music. Follow the steps below for the version of ACID you are using.

ACID Pro

1. Choose the FX fader in the Track List section that corresponds to the number of the effect you wish to use. For example, if you want to send your drum Track to the reverb that you selected on the FX 1 page, you would change the fader mode of the drum Loop Track to FX 1.

2. Click the Play button on the Toolbar, and begin increasing the level of the fader while watching the FX Input meters on the FX page. The FX Input meters display the incoming signal level from all Tracks that are assigned to an effect. Ensure that the sum of all of the input levels does not cause the FX Input meter to clip. If the Clip indication is displayed, use the FX Input faders to the right of the Meters to decrease the overall input level.
**Note:** All effects are pre-fader. This means that the master volume of the Track will not affect the level going to the effect. In this way, you can effectively create an “insert” type effect by reducing the Track’s master volume and sending the Track completely into an effect.

3. Once you have a good input level for the effect, you can adjust the effect’s settings until you get the sound you want. For information about each effect’s specific controls, click the Help button on the FX page to display the effect’s online help file.

**Note:** The output of the effect is routed to the selected playback device using the FX Device Selector in the FX page (this is the button with the number on it). The level that is mixed back into the selected playback device is determined by the output level in the effect itself.

**ACID Music**

1. Click the FX button in the Track List.

2. Click the Play button on the Toolbar, and begin increasing the level of the fader while watching the FX Input meters on the FX page. The FX Input meters display the incoming signal level from all Tracks that are assigned to an effect. Ensure that the sum of all of the input levels does not cause the FX Input meter to clip. If the Clip indication is displayed, use the FX Input faders to the right of the Meters to decrease the overall input level.

3. Once you have a good input level for the effect, you can adjust the effect’s settings until you get the sound you want. For information about each effect’s specific controls, click the Help button on the FX page to display the effect’s online help file.
Saving Effects Presets

The settings of any plug-in that you have selected can be saved into a Preset that you can then call up for later use.

To save the current settings of a plug-in as a preset, type a new name directly into the Preset drop-down box and click the Save Preset button. The new preset is then available every time you use that plug-in. If you would like to update an existing user-defined preset with the current settings of the plug-in, click the Save Preset button and the new settings are written over the existing Preset.

To delete a Preset, select it and press the Delete Preset button.

Note: Built-in Presets cannot be deleted.

Adjusting Latency

The time it takes for you to hear the changes after you move one of the controls on a plug-in is called latency. This latency depends on a couple of things: the speed of your computer, and the amount of buffering that ACID does before sending data to the plug-in. ACID cannot control the speed of your computer, but it can change the way it buffers data.

By moving the Response to changes slider to the Fast end, you will effectively be making ACID buffer less data before sending it to the plug-in. This lowers the latency considerably. However, it also increases the chances that playback will gap or stutter. The Response to changes slider should be set to a position just slower than the point at which your audio begins to break up. This will give you the optimized amount of latency for your computer.

Tearing Off the Pages

Because some effects’ property pages will take up a substantial portion of the ACID window, ACID allows you to “tear” off the page into a new window and place it wherever you wish. To do this, click on the far-left side of the page and drag it to another location in the window. To reattach it again, click on the Close button (X) in the upper right corner of the window.

Alternatively, you can size the FX window to be smaller; however, the effect’s property page will not be fully visible and some controls will not be accessible.
Setting Track and Event Properties

The Properties window at the bottom of the ACID window contains options to modify the behavior of whole Tracks or Events on a Track. From this section you can “ACIDize” files, modify a Track’s stretching properties (in ACID Pro only), or edit the start point and pitch of a specific Event.

ACIDizing a File

ACIDizing a file involves adding an extra chunk of information to the audio file that is ACID-specific. This information contains all of the properties on the Track tab in the Properties page, including the stretching properties (in ACID Pro only), root note, and number of beats or tempo of the file. This information is then used by ACID to time stretch (in ACID Pro only) and pitch shift the file for you automatically when you open it.

All of the audio contained on the ACID CD-ROM is ACIDized. Non-ACIDized files will open fine; however, their stretching properties may not be optimized (in ACID Pro only) and they will not conform to the key of the current project.

To ACIDize a file, click on the Track tab of the Properties page and then click the Save As button in the upper-right corner of the tab. This button opens the Save dialog and allows you to save the ACIDized file as a new file, or a replacement of the current file.

If you cannot or do not wish to save a new file, you can set the properties anyway, and they are saved with the ACID project. However, this means that you will have to set the properties for every project in which you use a given loop. ACIDizing the file allows you to “set and forget” the properties so that it will work in any project you choose.

---

Note: If you edit an ACIDized file in another audio editing program, it is possible that the ACID-specific chunk of data will be removed. The file will have to be re-ACIDized in ACID.
Modifying Track Properties

The Track properties are the properties that determine how a file behaves in ACID. These are also the properties that get saved into the file when you ACIDize it.

There are three types of Tracks that ACID deals with: Loops, One-Shots and Disk-Based. These types are described in detail in the Explaining the Paradigm section on page 25. You can change how ACID uses the current Track by changing the Track type control on the Properties page Track tab.

When Loop is selected in the Track type field, the length of the original file, in beats, is required for ACID Pro to stretch it properly. Setting a value in the Number of beats control that does not match the actual file causes the loop to play at a different speed than normal. For example, specifying 8 beats for a Loop that is actually 4 beats causes the loop to play twice as slow at any given tempo.

When Disk-Based is selected in the Track type field, the tempo of the original file is required for ACID Pro to stretch it. If you do not want ACID to stretch the file at all, unselect the Stretch from tempo option. Like a Loop, if you specify a tempo that is not the actual tempo of the file, the Track plays at a different rate.

The Root note for transposing option sets the base note for Loops and Disk-Based Tracks that you wish to conform to the project key. If you do not wish a Track to transpose to the song key (i.e., a Track that contains a drum sample) choose the Don’t transpose option.

Modifying the Stretching Properties

The stretching properties are the parameters that ACID uses to do the time compress and expand functions on the audio Events. If you are hearing audio anomalies due to the time compression, try editing the stretching properties for the Track. ACID does a good job auto-creating these properties when you first open a new Track, but it is possible for certain types of material to react differently.

Click on the Properties page at the bottom of the ACID window and click the Stretch tab. The Stretch page displays. The area on the right side of this page displays the waveform of the Track and the Stretch Markers that ACID has automatically placed. These Markers correspond to detected subdivisions of beats in the audio file. Accurately detecting these beats is key to making the time compression process sound good.

There are different ways to edit the beat detection in the Stretch page. The easiest way is to use the Stretching method, Force divisions and Additional transient detection options.
There are three Stretching methods available: Looping segments, Non-looping segments, and Pitch shift segments. The Looping segments method is the default, and works well with most types of material. The Non-looping segments method tends to work better for material like synth pads and held notes from guitars, basses, etc. The Pitch shift segments method shifts the pitch of the Track to adjust for increases and decreases in tempo. Using this option, you can eliminate some of the problems that occur with extreme tempo changes.

The Force divisions slider controls the resolution of the beat detection. Audio that contains rapid notes like drum rolls benefits from setting the divisions at a smaller fraction of a beat, i.e., thirty-second notes. Slower-paced material, however, may actually suffer from the Force divisions slider being set at too high a resolution.

Additional transient detection is the amount of extra beat detection that ACID will do for any given beat subdivision, as specified by the Force divisions slider. A higher percentage detects a greater number of transients. Increasing this number can be advantageous when working with audio that has complex rhythms. Lower numbers are more suitable for synth pads and other basic material.

The Stretch Markers in the area on the right can also be manipulated by hand. If ACID does not detect a transient correctly, you can move the Marker by clicking on and dragging it to a new location. The Marker color turns to blue, indicating that it has been edited.

Click the Add Markers button on the right side of the Stretch page and click above the Beat Ruler to add a new Marker. It is advantageous to add new Markers if ACID does not detect any quick sub-divisions in beats that are contained within the audio. The biggest cause of audio artifacts due to the time compression is lack of beat detection. Make sure that you add Markers anywhere that ACID fails to put one on a pronounced beat.

A Marker can also be disabled by clicking the Disable Markers button and clicking on the Marker to be deleted. Disabling a Marker can be beneficial if ACID is detecting a beat where it should not be detected. A disabled Marker will turn white.

To reset the Stretch Markers to their default position, click the Reset to Default Markers button. All default Markers are red.
Note: As a general rule, Markers should not be excessively close to each other. This may cause clicks in the audio. However, they should not be farther apart than about one second, either. This may result in strange pitch and echo artifacts.

Modifying Event Properties

Individual Events on Tracks also have their own set of properties. These properties include a Start offset, Pitch shift, and a Quick fade edges to prevent clicks option. These properties are not saved into the files when a Track is ACIDized. They are only saved with the project.

The Start offset setting for an Event specifies a playback starting position that is different than the beginning of the file. This offset is handy for adding extra variation to your Tracks by starting them at different places. This is especially useful for Loops; you can change the feel by simply starting the Loop at beat 2 rather than beat 1.

There are three different ways to edit the Start offset option. The most precise way is to type in the number of samples by which you want to offset in the Start offset field. For obvious reasons, this is probably not your preferred way of editing the offset. Another way is to move the blue Start Offset Marker in the waveform display on the right side of the Event page. The third method can be accomplished right from the Track View window. Hold down the Ctrl and Shift keys and click on the Event that you wish to offset. Now, drag the mouse left or right to change the offset. Notice the waveform scrolling within the Event boundaries.

When you add an offset to an Event or even edit an Event such that it does not end on a loop point, it is quite possible to introduce a click in the playback at the edges of the Event. This click can be easily eliminated by selecting the Quick fade edges to prevent clicks checkbox. ACID then performs a very quick fade in or out on the Event edges so that any nasty clicks are smoothed out of existence.
Advanced Track Editing

Once you have become familiar with the basics of creating and editing your ACID projects, you will want to start experimenting with some of the more advanced procedures.

Using Envelopes

Envelopes increase the power of ACID by allowing you to vary volume, pan and FX send (in ACID Pro only) levels over time per Event. This allows you to create fades, apply crazy panning and add effects (in ACID Pro only) that come and go as you please.

**Note:** An Envelope is specific to the Event on which it is acting. The Master fader in the Track List section always acts upon the entire Track. This means that any Event-specific Envelopes are calculated after the Master is calculated.

Adding an Envelope to an Event is accomplished by right clicking on the Event. Select Envelope and choose the type of Envelope you would like to add. The number of FX choices in the menu for ACID Pro is dependent on the Number of FX pages to display setting on the Preferences General page (accessible from the Options menu by clicking Preferences).

Any number of Envelopes can be added to an Event, but this will quickly clutter up the display of the Event. If you have ACID Pro, you may choose to hide or show any type of Envelope by choosing Display Envelopes from the View menu and selecting the type of Envelopes you would like to hide or show. A hidden Envelope still acts upon the Event; it is simply not displayed.

By default, a new Envelope contains a single Envelope point. If you want to simply adjust the overall level of a specific Event, you can click on the Envelope line and drag it up or down. A floating tool tip window shows you how much you are adjusting the Envelope.

To create more complex Envelopes, you need to add more points. To add a point to the Envelope, double-click on it. A new Envelope point is added, which can then be dragged and positioned as required. To delete a point, right-click on it and select Delete from the shortcut menu.

Each segment of an Envelope can be linear, fast logarithmic or slow logarithmic. To change the nature of the Envelope, right-click on it and select the Linear Fade, Fast Fade, or Slow Fade option from the shortcut menu. When dealing with fades, logarithmic fades usually sound more natural to the human ear than linear fades.
Different Tools

While most of the functions that you will use can be initiated using the Draw tool, there are five other tools that make specific tasks easier. The other tools include Paint, Erase, Envelope, Select and Zoom.

The Paint Tool

The Paint tool is designed to paint Events across multiple Tracks. With the Paint tool selected, Events can be painted across multiple Tracks as easily as clicking and dragging the mouse. Different from the Draw tool in that it can cross Track boundaries, the Paint tool excels at adding a random element to your ACID projects.

Painting across two or more existing Events on a Track effectively merges them into one contiguous block. This is useful if you need to repair a gap that you created using the Erase tool.

Note: Right-clicking with the Paint tool causes the tool to function like the Erase tool.

The Erase Tool

The Erase tool allows you to “spot erase” sections of an Event. With the Erase tool selected, click once in the middle of an Event. The Event splits at the closest snap point to the spot where you clicked. If you click and drag with the Erase tool across an Event, the Event is erased in chunks equal to the current snap value.

Note: Right-clicking with the Erase tool causes the tool to function like the Paint tool.

The Envelope Tool

The Envelope tool is only designed to manipulate Envelopes in Events. The Envelope tool should be used when you need to select multiple Envelope points to move together or when there is concern about accidentally moving an Event. With the Envelope tool selected, Events cannot be moved or edited.

To select multiple Envelope points, click on the Event whose points you wish to select and then drag the selection box around them. Selected points are displayed in an alternate color. When the points are selected, you may click on any point and drag it to the new position. All of the points follow. To deselect the points, click anywhere in the Event that is not part of the Envelope.
The Select Tool

The Select tool is designed to quickly select multiple Events across Tracks using selection boxes. There are three types of selection boxes that can be drawn using the Select tool: vertical, horizontal and free selection.

To change the type of selection box you are using, right-click the mouse while holding down the left mouse button. Clicking the right mouse button toggles between the three types of selection boxes.

The free selection box is the default behavior of the Select tool. It allows you to draw a selection that begins where you start drawing and ends where you let up on the mouse. This selection box selects all of the Events that are touched by the extents of the box. This method is good for selecting a group of Events that are close together.

The vertical selection box can be used to easily select Events across all Tracks that occur within a specified time range. The vertical selection box automatically selects all of the Tracks between your first mouse click and where you draw the selection box; even Tracks that are not visible at the current magnification are selected.

The horizontal selection box can be used to easily select all Events on a single or multiple adjacent Tracks. The horizontal selection box automatically selects all of the Events on a Track that are touched by the extents of the selection box; even Events that are not visible at the current magnification are selected.

The Zoom Tool

The Zoom tool is designed for changing the magnification of the ACID project. Like the Select tool, there are three types of zoom boxes that the Zoom tool can use: time, height and free zoom.

To change the type of zoom box you are using, right-click the mouse while holding down the left mouse button. Clicking the right mouse button toggles between the three types of zoom boxes.

The free zoom box is the default behavior of the Zoom tool. It allows you to zoom into a section of your ACID project in both time and level at the same time.

The time zoom box is used to zoom into a specific chunk of time in the ACID project while maintaining the current track height zoom. Click and drag anywhere across the ACID project to zoom into that specific area of time.
The track height zoom box is used to maximize the size of a Track or group of Tracks in the ACID window. This action allows edits to be made with reference to the low-level audio in the Event, thereby resulting in greater precision. Click and drag anywhere from top to bottom in the ACID project to zoom into the Tracks encompassed within the zoom area.

**Note:** Double-clicking anywhere on the project with the Zoom tool zooms out so that the entire project fits in the Track View.

**Using Markers**

Markers are a handy way to ease navigation in the Track View. To create a Marker, place the cursor in the project where you want to add it and press the `M` key on your keyboard. A Marker is added at the cursor position.

Markers can be used to indicate sections of projects such as chorus, verse, etc. They can also be used for on-the-fly actions such as marking a part in the project that you want to come back to edit later on. To move a Marker, simply click on its tab above the Beat Ruler and drag it to a new location.

More options are available by right-clicking on the Marker tab. Deleting a Marker, for example, is accomplished by clicking the **Delete** option on the shortcut menu. Naming a Marker is accomplished by clicking the **Rename** option on the shortcut menu.

Each Marker (up to 10) is assigned a number. Pressing this number on the keyboard moves the cursor to the corresponding Marker. You can even perform this action while playing the project.
Tempo and Key Changes

ACID allows you to add automatic tempo and key changes within a project using Tempo and Key Change markers. These markers are added on the Time Ruler at the bottom of the Track View. When the cursor passes over one of these markers, the master project tempo and/or key changes in real time.

To add a Tempo and/or Key Change marker, right-click on the empty bar directly between the Time Ruler and the horizontal scroll bar, and choose the type of change you would like to add from the shortcut menu. The markers that are added can be a Tempo Change, Key Change, or both.

There are two ways to edit the tempo and/or key of the marker. The first way is to place the cursor on or after the marker and adjust the Tempo slider and Key control at the bottom of the Track List. The settings of these controls are reflected in the text of the marker. The second way is to double-click on the text of the marker and type the exact value you want.

Note: When editing a combination Tempo and Key Change marker, you do not have to type both values if you only want to edit one of them. For example, if the current marker value is 130,A and you only want to edit the key, you can simply type “B” and press the Enter key. The marker is then 130,B. Tempo works the same way.

Changing Snaps

Snapping is a way to make sure that all of your Events and Markers in the Track View line up perfectly with each other. ACID allows you to change the resolution of the snapping to accommodate your working style.

To change the snap resolution, choose the Snap To option from the Options Menu and select the resolution you want to use. To disable snapping completely, uncheck the Enable Snap To option from the Options menu (do this by clicking on the option; the check mark to the left of the option in the menu is removed).

Note: You can temporarily disable snapping while editing an Event by holding down the Shift key.
Time Code Synchronization

ACID Pro can generate MIDI Time Code (MTC) and MIDI Clock as well as chase to MIDI Time Code. These features allow ACID to be synchronized with other audio applications and external audio hardware.

Generating MIDI Time Code

MIDI Time Code is a standard time code that most applications and some hardware devices will use to synchronize themselves. ACID generates stable MTC at all available frame rates for other applications to chase to.

To generate MTC from ACID, you must specify a MIDI Output device to send the time code to and a Frame rate for the time code. These options can be found on the Sync page of Preferences (accessible from the Options menu by clicking the Preferences option). After these options have been chosen, Generate MIDI Time Code must be turned on in the Options menu (do this by clicking the Generate MIDI Time Code option once, placing a check to the left of the option on the menu).

ACID then generates MTC starting from wherever you begin playback in your ACID project.

To view the outgoing time code, look at the Position Display directly above the Track List. Click on the button and choose MIDI Time Code Out. The text then displays the outgoing MTC time.

Note: If you have specified an Offset in the Sync page of the Preferences dialog, it is reflected in the Position Display as well as the Time Ruler, if the Time Ruler Format is set to a SMPTE format.
Chasing MIDI Time Code

ACID will also chase to incoming MTC. This means that ACID varies its playback speed over time to match the playback speed of another application or hardware device.

To chase to MTC, you must specify a MIDI Input device from which to receive MTC, and a Frame rate for the time code. These options can be found on the Sync page of the Preferences dialog (accessible from the Options menu by clicking the Preferences option). After these options have been chosen, Chase to MIDI Time Code must be turned on in the Options menu (do this by clicking the Chase to MIDI Time Code option once, placing a check to the left of the option on the menu).

ACID is then ready to chase to incoming time code. Whenever an incoming MTC signal is received, ACID begins playing from the position indicated by the time code. If ACID is not receiving MTC, you can play and edit as normal.

To view the incoming time code, look at the Position Display directly above the Track List. Click on the button and choose MIDI Time Code In. The text displays the incoming MTC time.

This display also shows status and error information. If Chase to MIDI Time Code is enabled but no MTC is detected, the display will read Listening… If the wrong frame rate of MTC is being detected, the display reads Wrong format.

Note: If you have specified an Offset in the Sync page of the Preferences dialog, it is reflected in the Position Display as well as the Time Ruler, if the Time Ruler Format is set to a SMPTE format.
Generating MIDI Clock

MIDI Clock differs from MTC in that it contains tempo as well as positional information. MIDI Clock is essentially measured in ticks from the beginning of the project. Ticks are a subdivision of quarter notes and are completely tempo-dependent.

The advantage of using MIDI Clock is that ACID can send its tempo changes to the chasing application, and they will be preserved.

To generate MIDI Clock from ACID, you must specify a MIDI Output device to send the Clock. This option can be found on the Sync page of the Preferences dialog (accessible from the Options menu by clicking the Preferences option). After this option has been chosen, Generate MIDI Clock must be turned on in the Options menu (do this by clicking the Generate MIDI Clock option once, placing a check to the left of the option on the menu).

ACID then generates MIDI Clock starting from wherever you begin playback in your ACID project.

To view the outgoing MIDI Clock position, look at the Position Display directly above the Track List. Click on the button and choose MIDI Clock Out. The text displays the outgoing MIDI Clock time.

Creating a CD

Once you have created and saved your ACID project, you can easily record it to a CD using your CD recorder. Before you begin, make sure that you have set your Preferences options for creating CDs on the Create CD tab.

Adding Tracks to a CD

You can begin the CD creation process using the Create CD button on the Toolbar, or the Create CD menu. The steps below assume the use of the menu. Follow these steps to create a CD containing your Track:

1. If you have not already done so, save your project.
2. From the **Create CD** menu, choose the **Add Track** option. The Create CD dialog displays. This dialog displays the length of the current ACID project and the amount of time remaining on the disc in your CD recorder.

**Note:** If you do not have a disc in your CD recorder drive when you access the Create CD dialog, all options other than the **Cancel** button are unavailable. If you insert a disc into your CD recorder after you access the Create CD dialog, it will take a moment or two for ACID to recognize the disc and make additional options available.

3. Click the **Add Audio** button. A status bar displays while ACID creates CD audio from the song. When the creation is complete, ACID begins writing the song to your disc. The approximate time remaining displays at the bottom of the window.

**Note:** Do not click the **Cancel** button once the disc writing process has begun. As with any CD recording process, interrupting the writing process makes your disk unusable.

When ACID is finished writing the song, a message displays, indicating that the writing was completed successfully.

4. Click the **OK** button.

5. To add more songs, repeat steps 2-4. To close the disc, proceed to the next section.

**Note:** Your disc cannot be played in an audio CD player until you close the disc.
Closing the Disc

After you have added all of the songs you want to your CD, you must close the disc before you can listen to it in an audio CD player. This task is easily accomplished by ACID. Follow the steps below to close a disc:

1. From the Create CD menu, choose the Close Disc option. The Create CD dialog displays.

2. Click the Close Disc button. The approximate time remaining displays at the bottom of the window. When ACID is finished closing the disc, a message displays, indicating that the closing was completed successfully.

3. Click the OK button. The disc is now ready for use in your audio CD player.

Note: You will not be able to add audio Tracks to the disc after you close it.
ACID Reference

Defining the ACID Program

This section is devoted to explaining the function of every menu item and dialog box in ACID. Look here to answer questions like, “I wonder what this button does?” Our explanation is separated according to the menus found in the ACID product.

File Menu

The options on the File menu are listed below.

New

Selecting this command opens a blank ACID project. If you currently have an ACID project open that has not been saved, you are prompted to save your changes first.

Open

Selecting this command displays the Open File dialog. From this window, you can browse all of the available drives to select an ACID project or audio file to open.

If you choose an ACID project and there is an unsaved project currently open, you are prompted to save your changes first. If you choose an audio file, the file is opened as a new Track in the current ACID project.

The options and fields on the Open File dialog are explained below.
Look in
This field specifies the current folder. All of the files available in the folder appear in the list below.

File name
This field specifies the file you wish to open. You may type a name or click on a file in the list above.

Files of type
This field specifies the type of file you wish to open. The type of file selected limits which files are shown in the list above. The types available are:

ACID Projects and Audio Files (*.acd, *.aif, *.wav)
An ACID project file (*.acd) contains all of the information about a single project. All of the Track layout, Envelope adjustments (in ACID Pro and Music only), effects parameters (in ACID Pro and Music only), etc. are saved in this project file.
Wave files (*.wav) are the standard audio file format for digital audio on Windows computers. ACID will allow you to open any 16 or 24-bit PCM, non-compressed Wave files.
AIFF (Audio Interchangeable File Format) files (*.aif) are a popular audio format on the Macintosh. ACID will allow you to open 16 and 24-bit files of this format.

Recent
The Recent list is a quick way to navigate the Open File dialog. Folders that you frequently use are available to choose from the list. All of the files in that folder appear in the list above.

Close
This command closes the current project.

Save
This command saves the changes to the current project.
Save As

This command displays the Save As dialog. From the Save As dialog, you can save the current project to a different location, with a new name, or as an AIFF, WAV, Windows Media Format, RealMedia, or MPEG Layer 3 file.

The options and fields on the Save As dialog are explained below. The options available to you depend upon the option you select in the Save as type field.

Save in
This field specifies the folder to which you wish to save. All of the files available in the folder appear in the list below.

File name
This field specifies the file you wish to save. You may type a name or click on a file in the list above.

Save as type
This field specifies the type of file to which you wish to save (for example, *.acd or *wav files). These file types are explained below.

ACID Project (*.acd)
An ACID project file contains all of the information about a single project. All of the layout of Tracks, Envelope adjustments (in ACID Pro and Music only), effects parameters (in ACID Pro and Music only), etc. are saved in this project file. This type of file does not contain any audio, only references to audio files.

ACID Project with external audio (*.acd)
By saving a project with external audio, all of the audio that is being used in the project is copied into the same folder as the project file. This action makes it easy to move a project around without having to reestablish the audio file references every time.

When this option is selected, an Include Disk-Based audio files checkbox is displayed. Clear this check box if you do not want Disk-Based Tracks to be copied with the new project; links to the files are still contained in the project.
ACID Project with embedded audio (*.acd)

By saving a project file with embedded audio, all of the audio files used in the project are embedded into the project file. This option is ideal for archiving a finished project, since there is only one file to keep track of.

When this option is selected, an Include Disk-Based audio files check box is displayed. Clear this check box if you do not want disk-based tracks to be copied with the new project; links to the files are still contained in the project.

Mixed AIFF File (*.aif)

The entire project can be rendered into a single AIFF file by choosing this option. When this option is selected, a new drop-down list called Attributes is displayed. Use the Attributes drop-down list to choose the desired sample rate, bit depth, and number of channels for the output file.

Mixed Wave File (*.wav)

The entire project can be rendered into a single wave file by choosing this option. When this option is selected, a new drop-down list called Attributes is displayed. Use the Attributes drop-down list to choose the desired sample rate, bit depth, and number of channels for the output file.

Mixed Windows Media (*.asf or *.wma)

The entire project can be rendered into a Microsoft Active Streaming Format file for broadcast over the Internet. When you choose this option, a new drop-down list called Preset is displayed.

The Preset list contains a set of commonly-used formats for creating Internet-ready audio.

RealMedia (*.rm)

Choose this option to render the project as a RealMedia file for broadcast over the Internet. When this option is selected, a Preset drop-down list and an Advanced button are displayed.

The Preset list contains a set of commonly-used formats for creating Internet-ready audio. If you do not wish to use a preset from the list, click the Advanced button to create a custom template.
MPEG (Moving Picture Expert Group) Layer 3 (*.mp3)

The entire project can be rendered into a MPEG Layer 3 (*.mp3) file by choosing this format and using the Sonic Foundry MP3 Plug-In. MP3 allows you to store audio in a much smaller file, while retaining much of the quality of the sound. When you click the Save button after choosing the MP3 option, the Sonic Foundry MP3 Plug-In dialog displays, allowing you to make specific selections for encoding to MP3. For more information on these encoding options, please refer to What’s This? help within ACID.

ACID allows you to perform twenty MP3 encodes. The number of evaluation encodes remaining on your system is displayed at the bottom of the Sonic Foundry MP3 Plug-In dialog. If you wish to encode additional MP3 files beyond your initial twenty, you can unlock the Sonic Foundry MP3 Plug-In by clicking the Purchase button, and then obtaining a registration key by phone or from the Sonic Foundry web site.

Save only the audio within the current Loop Region

When this option is checked, only the portion of the project that is contained within the Loop Region is saved out to a new file. The Loop Region does not need to be active for this option to work.

Export

This command allows you to export audio from the current project in various forms. When you select this option, the Export dialog is displayed. The options and fields on the Export dialog are explained below.

Save in

This field specifies the folder to which you wish to export. All of the files available in the folder appear in the list below.

Folder

This field displays the full path of the destination folder.

Save as type

This field specifies the type of file format to which your exported audio will be saved. These file formats are explained below.

AIF (*.aif)
The AIF or AIFF format is a popular format on the Macintosh.

Wave (*.wav)
This is the standard audio file format for digital audio on Windows computers.
Attributes
This field allows you to choose the format of the exported audio. Select the sample rate, bit-depth, and number of channels from this drop-down list.

Export type
Select an Export type from this drop-down list. The types are explained below:

Save each Track as a separate file
This command saves out copies of all un-muted tracks as separate files. This feature is useful when you want to export each of your arranged tracks into another application.

Save Loop files at project tempo
This command saves out new copies of all of the un-muted Loops that you are using in the current project at the current project tempo. This is a useful feature when you want to export the Loops to another application in their time-stretched state.

Free space
This field displays the available space on the hard drive where the selected folder is located.
Properties

Selecting this command displays the Properties dialog. From this dialog, you can store information about the current project. This information is saved with the ACID project and can be displayed by media players when you save your project in different file format. The options on the Properties dialog are explained below.

Title
Enter the title of the project.

Artist
Enter the name of the artist who performed in the project.

Engineer
Enter the name of the person who engineered the project.

Copyright
Enter copyright information about the project.

Comments
Enter any comments you want to associate with the project.

Exit
This command closes the ACID application. If you currently have an unsaved ACID project open, you are prompted to save your changes first.
Recently Used Files List

A list of recently used project files is maintained at the bottom of the File menu. Choosing a project from this list allows you to quickly return to work on that project.

Note: If you have moved or deleted any of the files used in a project (or if the CD containing a loop is not in your CD-ROM drive when you open the project) ACID prompts you to locate the missing file. Click Yes if you want to browse to a new location for the file, or click No to open the project without the missing file(s). If you click No and save the project, ACID deletes the project’s link to the file.

Edit Menu

The options on the Edit menu are listed below.

Undo

Use this command to reverse the last action performed. For instance, if you deleted a Track by accident, simply choose the Undo option from the Edit menu to restore the Track.

Note: ACID allows you to perform an unlimited number of Undos, so you can restore the project to any state since the last Save command.

Redo

Use this command to reverse an Undo operation. For instance, if you decide that you really did want to delete that Track, select Redo and the undo is reversed.

Cut

Selecting this command removes any selected Events in the Track View and places them onto the ACID clipboard.
Copy
Selecting this command creates a copy of any selected Events in the Track View and places them onto the ACID clipboard.

Paste
Use this command to insert the contents of the ACID clipboard at the current cursor position. The clipboard contents are placed on top of any Events that occupy the same space in the Track View. To force existing Events to move in time to accommodate the pasted Events, use the Paste Insert option.

Paste Insert
Use this command to place the contents of the ACID clipboard at the current cursor position and force existing Events to move in time to accommodate the pasted Events.

Note: If the cursor is in the middle of an Event, the Event is split at the cursor position when the new Events are pasted.

This feature is useful when rearranging a project by moving verses and choruses around.

Delete (Clear)
This command removes any selected Events from the Track View.

Select All
This command selects all of the Events in the Track View.
Mix to New Track

This command mixes all audio contained in unmuted tracks into one single track. This function is similar to “track bouncing” in the analog world.

Note: If a Loop Region has been defined, only audio within the Loop Region is mixed to the new track.

The Mix to New Track dialog is displayed so you can choose a name and destination folder for the new file. The options and fields on this dialog are explained below.

Save in
This field specifies the folder to which you want to save your file. All of the files available in the folder appear in the list below.

File name
This field specifies the file you want to save. You may type a name or click on a file in the list above.

Save as type
This field specifies the type of file you want to save. Wave is the only available option.

Insert Silence
This command inserts a user-specified amount of silence into the ACID project at the cursor position. Specify the amount of time in measures.beats.ticks. You can use this feature to create space in the project for new Events.

Fit to Time
This command allows you to specify an exact length for the ACID project. ACID adjusts the tempo accordingly to conform to the new length. The maximum and minimum length is limited to reduce the possibility of creating audible artifacts through the compression/expansion process.
Tool

This sub-menu contains options to select the different tools that are available in ACID. The options on this sub-menu are listed below.

Draw

The Draw tool allows you to insert, edit, and select events in the Track View. By clicking on the empty track and dragging the Draw tool, an event is added. The longer you drag, the more times the loop is repeated. Repetitions in a loop are denoted by the black indentations in the top and bottom borders of the event.

Select

The Select tool is designed to quickly select multiple events across tracks by drawing selection boxes around the events you want to select. The Select tool can draw three types of selection boxes:

<table>
<thead>
<tr>
<th>Selection Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Free selection</td>
<td>The default behavior of the Select tool. It allows you to draw a rectangular region that begins where you start drawing and ends where you release the mouse button. All of the events that are inside the region will be selected. This method is good for selecting a group of events that are close together.</td>
</tr>
<tr>
<td>Vertical</td>
<td>Can be used to easily select all events that occur within a specified time range. The vertical selection box automatically selects all of the tracks between your first mouse click and where you draw the selection box; even tracks that are not visible at the current magnification are selected.</td>
</tr>
<tr>
<td>Horizontal</td>
<td>Can be used to easily select all events on a single or multiple adjacent tracks. The horizontal selection box automatically selects all of the events on a track that is touched by the extents of the selection box; even events that are not visible at the current magnification are selected.</td>
</tr>
</tbody>
</table>

To change the type of selection box you are using, right-click the mouse while holding down the left mouse button. Clicking the right mouse button toggles among the three types of selection boxes.
Paint

The Paint tool is designed to paint events across multiple tracks. With the Paint tool selected, you can paint events across multiple tracks by clicking and dragging the mouse.

The Paint tool is different from the Draw tool in that it can cross track boundaries. Use the Paint tool to add a random element to your ACID projects.

<table>
<thead>
<tr>
<th>Adding Events</th>
<th>Click and drag across Tracks to add Events.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Merging Events</td>
<td>Click and drag across two or more existing events to merge them.</td>
</tr>
<tr>
<td>Erasing Events</td>
<td>Right-clicking with the Paint tool selected causes the tool to function like the Erase tool.</td>
</tr>
</tbody>
</table>

Erase

The Erase tool allows you to “spot erase” sections of an event.

<table>
<thead>
<tr>
<th>Erasing Events</th>
<th>With the Erase tool selected, click and drag across an Event to erase sections equal to the current Snap to value.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Splitting Events</td>
<td>With the Erase tool selected, click once in the middle of an Event to split the Event at the closest snap point.</td>
</tr>
<tr>
<td>Painting Events</td>
<td>Right-clicking with the Erase tool selected causes the tool to function like the Paint tool.</td>
</tr>
</tbody>
</table>
Zoom
The Zoom tool is designed for changing the magnification of an ACID project. The Zoom tool can draw three types of zoom boxes:

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Free Zoom</td>
<td>The default behavior of the Zoom tool. It allows you to draw a rectangular region that begins where you start drawing and ends where you release the mouse button. It allows you to zoom into a section of your ACID project in both time and level at the same time.</td>
</tr>
<tr>
<td>Time Zoom</td>
<td>Used to zoom into a specific range of time in the ACID project while maintaining the current Track height. Click and drag anywhere across the ACID project to zoom into that specific area of time.</td>
</tr>
<tr>
<td>Height Zoom</td>
<td>Used to maximize the height of a Track or group of Tracks in the ACID window. This allows edits to be made with reference to the low level audio in the Event, thereby resulting in greater precision. Click and drag anywhere from top to bottom in the ACID project to zoom in to the Tracks encompassed within the zoom area.</td>
</tr>
</tbody>
</table>

Envelope
The Envelope tool is designed to manipulate envelopes in Events. Use the Envelope tool when you need to edit envelope points, but do not want to change Events. With the Envelope tool selected, Events cannot be moved or edited.

To select multiple envelope points, click on the an event and drag the selection box around the points you want to move. Selected points are displayed in an alternate color. Click any selected point and drag it to the new position; all selected points follow.

To deselect the points, click anywhere in the event that is not part of the envelope.
Special

This sub-menu contains options for adding different types of Markers to the Track View at the current cursor position. The options on this sub-menu are listed below.

Drop Marker
This command places a Marker at the current cursor position. Markers are a handy way to ease navigation in the Track View.

Add Tempo Change
This command places a Tempo Change Marker at the current cursor position. Tempo Change Markers are used to create automated, real-time tempo changes in the project.

Add Key Change
This command places a Key Change Marker at the current cursor position. Key Change Markers are used to create automated, real-time key changes in the project.

Add Tempo and Key Change
This command places a Tempo and Key Change Marker at the current cursor position. Tempo and Key Change Markers are used to create simultaneous, automated, real-time tempo and key changes in the project.

Undo All
Selecting this command reverts the project back to its last saved form, assuming that Undos have been created for each action that has taken place.
View Menu

The options on the View menu are listed below.

**Toolbar**

This option toggles the display of the Toolbar on and off. A check mark is displayed next to the Toolbar option when the Toolbar is displayed.

**Zoom Normal**

This command restores the project's magnification to the default settings. This feature is useful for quickly zooming to a reasonable level whether you are zoomed in or out to the magnification extents.

**Zoom Edit**

This command restores the track height zoom to a level where all Track List edit controls can be accessed. This feature is useful when you want to edit something in the Track List but do not want to change your time zoom magnification.

**Zoom Overview**

This command reduces the magnification of the Track View so that the entire length of the project and as many Tracks as possible are displayed.

**Display Event Pitch**

This option toggles the display of each Event's pitch in the Track View.
Display Envelopes

This sub-menu toggles the global display of each type of available Envelope. The options on this sub-menu are listed below.

Volume
This option toggles the display of volume Envelopes.

Pan
This option toggles the display of panning Envelopes.

FX
This option toggles the display of effects Envelopes. There will be an item for as many FX pages as are selected in Preferences.

Focus to Track View

This command sets the input focus to the Track View. All keyboard commands will affect the controls of the Track View.

Explorer

This command displays the Media Explorer page at the bottom of the ACID window. This command has the same function as clicking the Explorer tab.

Properties

This command displays the Properties page at the bottom of the ACID window. This command has the same function as clicking the Properties tab.

Mixer

This command displays the Mixer page at the bottom of the ACID window. This command has the same function as clicking the Mixer tab.

FX

This command displays one of the FX pages at the bottom of the ACID window. If you are using ACID Pro, there will be a separate menu command for each effect that is available. The number of available effects is determined in Preferences. This command has the same function as clicking one of the FX tabs.
Explore Current Folder

This command opens a Windows Explorer window of the currently selected folder. If a file is selected in the Media Explorer, Windows Explorer opens the folder where the file is saved. This is a useful feature for quickly renaming or deleting files since ACID’s Media Explorer cannot perform these actions.

Refresh Explorer

This command updates the Media Explorer window to show any changes in the drive or folder structure.

Create CD Menu

Use the Create CD dialog to save your ACID creations on audio CDs that you can share with others. The options on the Create CD menu are listed below.

Add Track

This option displays the Create CD window, which allows you to record your ACID song to a CD, using your CD recorder.

Close Disc

This option displays the Create CD window, which allows you to close your CD and listen to it in an audio CD player.

Note: You will not be able to add audio Tracks to the CD after you close it.
Options Menu

The options on the Options menu are listed below.

Scroll Playback

When this option is selected, ACID scrolls the Track View display when the play cursor reaches the edge of the screen.

Enable Snap To

This option toggles snapping off and on. All editing functions are constrained to the resolution specified in the Snap To setting when this option is enabled. A check mark is displayed next to the command when snapping is enabled.

Snap To

The Snap To sub-menu options change the resolution of the snapping. All editing functions snap to this setting when Enable Snap To is turned on. The options on the Snap To sub-menu are listed below.

Ruler Marks

This option sets the snapping to marks of the Time Ruler. The resolution of the marks depends on the current magnification of the Track View.

Whole Note

This option sets the snapping to whole measures.

Half Note

This option sets the snapping to half notes. In 4/4 time, a half note is two beats.

Quarter Note

This option sets the snapping to quarter notes. In 4/4 time, a quarter note is one beat.

Eighth Note

This option sets the snapping to eighth notes. In 4/4 time, an eighth note is one half of a beat.

Sixteenth Note

This option sets the snapping to sixteenth notes. In 4/4 time, a sixteenth note is one quarter of a beat.
Thirty-Second Note
This option sets the snapping to thirty-second notes. In 4/4 time, a thirty-second note is one eighth of a beat.

Sixty-Fourth Note
This option sets the snapping to sixty-fourth notes. In 4/4 time, a sixty-fourth note is one sixteenth of a beat.

Time Ruler Format
This sub-menu contains options for how to display time on the Time Ruler. The options on this sub-menu are listed below.

Samples
This option displays the Time Ruler in samples.

Time
This option displays the Time Ruler in hours:minutes:seconds.milliseconds.

Seconds
This option displays the Time Ruler in seconds.

Time & Frames
This option displays the Time Ruler in hours:minutes:seconds.frames where the frame rate is 15 frames per second.

Absolute Frames
This option displays the Time Ruler in total frames from the beginning of the project, where the frame rate is 15 frames per second.

SMPTE Non-Drop (29.97 fps)
This option displays the Time Ruler in hours:minutes:seconds.frames where the frame rate is 29.97 frames per second.

SMPTE Non-Drop (30 fps)
This option displays the Time Ruler in hours:minutes:seconds.frames where the frame rate is 30 frames per second.
SMPT Drop (30 fps)

This option displays the Time Ruler in hours:minutes:seconds.frames where the frame rate is 30 frames per second using dropped frames.

SMPL EBU (25 fps)

This option displays the Time Ruler in hours:minutes:seconds.frames where the frame rate is 25 frames per second for the European Broadcasting Union.

SMPT Film Sync (24 fps)

This option displays the Time Ruler in hours:minutes:seconds.frames where the frame rate is 24 frames per second for synchronizing with film.

Generate MIDI Time Code

When this option is selected, ACID generates MIDI Time Code whenever you click Play. To set up MIDI Time Code generation, open the Sync page in the Preferences dialog (accessed by selecting the Options menu, followed by the Preferences option).

Generate MIDI Clock

When this option is selected, ACID generates MIDI Clock whenever you click Play. To set up MIDI Clock generation, open the Sync page in the Preferences dialog (accessed by selecting the Options menu, followed by the Preferences option).

Chase to MIDI Time Code

When this option is selected, ACID watches for incoming MIDI Time Code and synchronizes playback. To set up chasing to MIDI Time Code, open the Sync page in the Preferences dialog (accessed by selecting the Options menu, followed by the Preferences option).
Customize Toolbar

This command opens the Customize Toolbar dialog. The options on this dialog are explained below.

**Available toolbar buttons**
This list contains all of the buttons that are not currently on the Toolbar.

**Current toolbar buttons**
This list contains all of the buttons that are currently on the Toolbar in the order in which they appear.

**Add**
This button moves the selected button from the Available toolbar buttons list to the Toolbar buttons list.

**Remove**
This button moves the selected button from the Current toolbar buttons list to the Available toolbar buttons list.

**Close**
Pressing this button closes the Customize Toolbar dialog.

**Reset**
Pressing this button sets the Toolbar back to its default setup.

**Help**
Pressing this button displays help for the Customize Toolbar dialog.

**Move Up**
Pressing this button moves the selected button up in the Current toolbar buttons list.

**Move Down**
Pressing this button moves the selected button down in the Current toolbar buttons list.
Preferences

The Preference command displays the Preferences dialog. This dialog contains pages which control various user options for ACID. These pages are explained below.

General

This page contains miscellaneous ACID options. These options are explained below.

Automatically open last project on startup

Select this check box if you want ACID to reopen the project that was open the last time ACID was closed. When the check box is cleared, ACID starts with a blank project.

Show logo splash screen on startup

Select this box if you want the ACID logo splash screen to be displayed when ACID starts.

Playback Buffering

Click and drag the slider left or right or use the arrows at the end of the slider to specify the total amount of buffering that ACID uses during playback.

Note: If you have problems with audio dropouts during playback, try increasing this value. However, selecting a large value will drastically reduce the responsiveness of starting playback.

Create permanent peak files (.SFK) for Disk-Based audio

Select this box if you want ACID to create peak (.sfk) files when you open Disk-Based Tracks. Peak files help accelerate opening, navigation, and zooming features.

Create Undos for FX parameter changes

Select this check box if you want ACID to create Undos when a plug-in parameter is changed in the FX pages.

Project tempo range

Use the up and down arrows or enter a value in the edit boxes to specify the minimum and maximum tempo available in the ACID project. Changing this option will affect the resolution of the Tempo slider.
Number of FX pages to display
Use the up and down arrows or enter a value in the edit box to specify the number FX pages to display. By adding more FX pages, you can use more effects in your ACID project.

Play files from disk if bigger than
Use the up and down arrows or enter a value in the edit box to specify the size above which opened audio files will not be stored in RAM.

Location of preferred audio editor
This field displays the location of the audio-editing application you want to use with ACID. To specify an audio editor, click the Browse button and browse for the editor's .exe file.

ACID starts this application when you click the Edit in Audio Editor button on the Properties page.

Temporary storage folder
This box displays the folder where temporary files are created. Click the Browse button to specify a new folder.

Free space in selected folder
This field specifies the amount of free space available in the selected Temporary storage folder.

Choose Language
Choose a language from the drop-down list. ACID will use this language for all displays the next time you start the program.

Note: Do not choose the Japanese option unless you are running a Japanese version of Windows.

Default All
Click to restore the General page options to the default settings.
Create CD

This page contains options specific to CD creation.

Drive

Select the drive you want to use to create CDs from the drop-down list.

Use temporary hard disk file when creating CD

When this box is checked, ACID renders the current project to a temporary .wav file before writing the song to CD. Use this option for slower computers when ACID cannot render your song fast enough to keep up with the CD-writing process.

Creation of temporary files before writing is turned off by default.

Speed

Select the speed of your CD recorder from the drop-down list.

Audio

This page contains options specific to playback and recording.

Keep audio devices open for faster playback startup response

Select this check box if you want ACID to keep all audio devices (sound cards) open to decrease the response time when you click Play.

Note: Audio devices will be released if you switch to a different application and ACID is not playing.

Show Sound Mapper in device selection for playback and record

Select this check box if you want the Microsoft Sound Mapper device to be available as an option for record and playback device.

If you never use the Sound Mapper for its format-conversion properties, clear the check box to remove it from the list of devices and save space.
Playback and record sample rate

Select a sample rate from the drop-down list to specify the sample rate ACID uses to play and record.

**Note:** Changing this rate at any time will not affect the pitch of the project.

Default playback device

Select a device from the drop-down list to specify the playback device that will be used for all new tracks. This device will be displayed first in the Device Selection list, and its playback meter is displayed first on the Mixer page.

Playback sample size

Select a bit depth from the drop-down list. This bit depth will be used for audio playback. There are two common and accepted ways to send 24-bit data to audio hardware: 24-bit packed and 24-bit unpacked. The sound quality of these two methods is identical. Most sound cards support both formats. If you get error messages when trying to play at 24-bit, try switching to the other 24-bit method:

Using 24-bit packed data, each 24-bit sample of data is sent in a “packed” 24-bit piece. When recording, this method can be more efficient and save hard drive space.

Using 24-bit unpacked data, each 24-bit sample of data is sent in a 32-bit “unpacked” piece. If you are recording, this type of data will take up more hard drive space, and may or may not be more efficient, depending upon the sound card.

Playback buffering

Click and drag the slider left or right or use the arrows at the end of the slider to specify the total amount of buffering that ACID uses during playback.

**Note:** If you have problems with audio dropouts during playback, try increasing this value. However, selecting a large value will drastically reduce the responsiveness of starting playback.
Location of preferred audio editor

This field displays the location of the audio-editing application you want to use with ACID. To specify an audio editor, click the Browse button and browse for the editor's .exe file.

ACID starts this application when you click the Edit in Audio Editor button.

Advanced

Click to open the Advanced Audio Preferences dialog. The options on this dialog are explained below.

Audio devices

This list contains all of the audio devices that are installed in your computer. Selecting one from the list allows you to set the options below for that device.

Interpolate position

When this option is checked, ACID attempts to compensate for inaccurate devices by interpolating the playback or recording position. If you notice that your playback cursor is offset from what you are hearing, enable this option for the playback device.

Position bias

If the position of playback or record is still off from what you hear after you enable Interpolate position, you can attempt to compensate using the Position bias control. Moving this control offsets the position forward or backward to compensate for the inaccuracies of the device.

Do not pre-roll buffers before starting playback

When this option is checked, ACID does not create buffers prior to starting playback. Some devices do not behave properly if this option is unchecked. If your audio stutters when you start playback, try checking this option.

Default All

Clicking this button restores the entire Audio page to the default settings.
Sync
This page contains options for setting up synchronization of other applications and devices to ACID. The options on this page are explained below.

Generate MIDI Time Code settings

Output device
Select a MIDI device from the drop-down list. MIDI Time Code will be sent to this device. The MTC slave should also be set to this device.

Frame rate
Select a frame rate from the drop-down list. ACID will use this frame rate to generate the MIDI Time Code. The MTC slave must be set to the same frame rate.

Offset
Select an offset value from the drop-down list. If the offset is 01:00:00.00, ACID will begin sending MTC at one hour.

Generate MIDI Clock settings
This setting is for setting up MIDI Clock generation from ACID.

Output device
Select a MIDI device from the drop-down list. MIDI Clock will be sent to this device. The MIDI Clock slave should also be set to this device.

Chase to MIDI Time Code settings
These settings are for setting up MIDI Time Code chase to another application or external device.

Input device
Select a MIDI device from the drop-down list. MIDI Time Code will be received from this device. The MTC master should also be set to this device.

Frame rate
Select a frame rate from the drop-down list. This value specifies the frame rate at which the MTC master will send time code to ACID.

Offset
Select an offset value from the drop-down list. If your incoming time code starts at 1 hour, you should specify ACID's start time as 1 hour as well. Specifying an offset saves you the trouble of moving all of the events in your project to the 1-hour point in order to synchronize them properly.
Synchronize audio playback devices to opened sample rate

Select this check box if you want audio devices to be allowed to play back at the rate of their internal crystal clocks.

Even if your playback sample rate is 44.1 kHz, some audio cards will actually play back at a slightly different rate. This is normally not a problem, unless you are using two different sound cards and are playing from them simultaneously. If one of the cards is playing at a different rate, the two cards will eventually drift out of sync from each other. When this option is checked, ACID will attempt to compensate for this by resampling its playback.

Advanced

Click to open the Advanced Sync Preferences dialog.

MTC Output

This page contains advanced options for MIDI Time Code (MTC) output. It is only displayed if a device is selected for MTC output on the previous page. The options on this dialog are explained below.

Use internal timer for MTC generation

When this option is enabled, the MIDI Time Code that ACID generates will be based off of the CPU clock. Otherwise, it will be generated from the clock on the sound card.

Internal timer resolution

When using the internal timer, the resolution of the timer can be changed. Higher numbers indicate lower resolution, and vice versa.

Full-frame message generation

This option specifies when ACID will send full-frame time code messages while Generate MIDI Time Code is enabled. Full-frame messages are used by some external synchronizable audio devices to seek to a proper location prior to actually starting synchronization. Tape-based recorders especially benefit from seeking to full-frame messages because of the time it takes to move the transport to the proper location. However, full frame messages are ignored by some devices and may actually cause unexpected behavior in other devices. Check your hardware documentation to find out if they support full-frame messages.

MIDI Clock Output

This page contains advanced options for MIDI Clock output. It is only displayed if a device is selected for MIDI Clock output on the previous page.

Send Start instead of Continue when beginning playback

When this option is checked, ACID sends a Start command rather than a Continue command when Generate MIDI Clock is enabled. Normally, ACID sends a Continue
command as this type of command allows the chasing device to start from a specific time. However, some older sequencers that support MIDI Clock chase do not support the Continue command and must start from the beginning every time.

**Use internal timer for MIDI Clock generation**

When this option is enabled, the MIDI Clock that ACID generates is based off of the CPU clock. Otherwise, it is generated from the clock on the sound card.

**Always send MIDI Clock**

When this option is selected, ACID always sends MIDI Clock when Generate MIDI Clock is enabled. Some applications and devices listen for MIDI Clock, even when the master application is not playing. This allows them to synchronize faster. However, some applications and devices might not support this feature. It is recommended that you turn off this option if your MIDI Clock slave does not support it.

**Song Position Pointer generation**

This option specifies when ACID sends Song Position Pointer messages while Generate MIDI Clock is enabled. Song Position Pointer messages are used by MIDI applications and devices to seek to a proper location prior to actually starting synchronization.

**MTC Input**

This page contains advanced options for MIDI Time Code input. It is only displayed if a device is selected for MTC input on the previous page.

**Trigger playback only (do not chase)**

When this option is selected, ACID does not chase its playback speed to the incoming MTC. Instead, it will only trigger at the appropriate time. There are two situations when you will want to use this option:

- If your computer does not have the speed required to accurately chase time code. This method is not recommended for long periods of time, as ACID will drift out of sync, but it may be successfully used for short periods.
- Your sound card has an external “Word Clock” input. This stable clock source keeps your digital signals locked together and eliminate the need for ACID to chase.
Free-wheel for time code loss
When this option is selected, ACID continues to play for a specified period of time without chasing if time code is lost for some reason. Enabling this option can compensate for infrequent losses in time code. If losses in time code are frequent, troubleshooting should be done to find the cause of the problem.

Free-wheel slack time
This option specifies the amount of time that time code can be lost before the Free-wheel playback time starts. A longer time is more tolerant of breaks in the incoming time code.

Free-wheel playback time
This option specifies the amount of time that ACID will play back after the Free-wheel slack time has been exceeded.

Synchronization delay time
This option specifies the amount of time it takes for ACID to synchronize itself to incoming time code. On slower computers, this time should be set to around two seconds. On faster computers, it may be set lower. However, setting this value too low can sometimes result in wild audible pitch-shifting at the start of playback.

Default All
Clicking this button restores the entire Sync page to the default settings.

Help Menu
The options on the Help menu are listed below.

Contents and Index
This command displays the ACID Help file. Use the Contents, Index, and Search tabs to find the topic you're looking for.

What’s This?
This command allows you to view context-sensitive help about the items in ACID's main window and dialog boxes.

Keyboard Shortcuts
This command displays the Keyboard Shortcuts topic of the Help file. Here you will find numerous shortcuts to speed up your work in ACID.
Get Loops

If you'd like to purchase additional loops for use in ACID, choose Get Loops from the Help menu or click the Get Loops button on the toolbar. ACID starts your Web browser and take you to the Loop Library page on the Sonic Foundry Web site. You'll be able to see a list of available Loop Libraries and get more information.

ACIDplanet.com

If you're a registered ACID user and want to share your ACID creation on the Web, you can publish it to the ACIDplanet Web site (http://www.acidplanet.com). This process is explained below:

1. From the Help menu, choose ACIDplanet.com, or click the Publish to ACIDplanet button on the Toolbar to open the Publish to ACIDplanet wizard.

2. Specify the type of file you want to publish:

   • Choose the Publish the current song radio button to publish an ACID project that has not been saved as a Windows Media Format file. If you choose Publish the current song, you can select a format for your song.
     
     Choose the Encode for Download radio button if you want users to be able to download your song.
     
     Choose the Encode for Streaming radio button if you want your song to stream over the Internet.
     
   • Choose the Publish an existing file radio button to publish an ACID project that has been saved as a Windows Media Format file. Click the Browse button to locate your file.

3. Click the Next button.

4. Enter summary information for your song. This information is displayed in the Windows Media Player when users listen to your song.

5. Click the Next button.

6. Enter your email address and an artist name, and click the Finish button to start uploading your song.
Instant Upgrade

This command displays the Upgrade dialog. Follow these steps to try or buy an instant upgrade to a higher version of ACID:

1. From the Help menu, choose Instant Upgrade to display the Upgrade dialog. The dialog will display the version of ACID that you are currently running and provide a list of upgrade options.

   **Note:** If you are running ACID Pro, no upgrades are available.

2. Select an upgrade from the list.

3. Choose an upgrade type:

   - Choose the Try it! radio button if you want to try a demonstration version of the software.
   - Choose the Buy it! radio button to purchase the software.

   **Note:** For more information, click the More Info button to open the Sonic Foundry home page in your Web browser.

4. Click the Next button.

5. Register your new software:

   - Choose the I want to purchase/register online radio button if you can connect to the Internet to get your new product unlock key using Sonic Foundry’s secure server. When you click the Next button, your Web browser will connect you to the Sonic Foundry registration page. Follow the on-screen prompts to get your new key.
   - Choose the I want to purchase/register over the phone radio button if you cannot connect to the Internet to get your new product unlock key. Call our Sales and Customer Service department at one of the following numbers:
     In the United States: 1-800-57-SONIC [1-800-577-6642]
     Outside the United States: 001-608-256-5555

   When you click the Next button, a dialog box will be displayed with your serial number and Computer ID.
6. Enter your new product unlock key in the dialog box and click Finish. If you purchase or register online, your product unlock key will be sent to you via email. You can copy the key from the message and paste it into the box.

7. Store the key in a safe place in case you need to reinstall ACID.

**Check for Update**

From the Help menu, choose Check for Update to start your Web browser and go to the Sonic Foundry Web site to see if an update is available for your version of ACID.

**Sonic Foundry on the Web**

This sub-menu contains links to various pages on our World Wide Web site. The options on this sub-menu are listed below.

**Product News**
This command opens the News page in your Web browser. Here you will find announcements about new and existing products.

**Frequently Asked Questions**
This command opens the FAQ page in your Web browser. Here you will find answers to most common questions regarding Sonic Foundry's products.

**Online Support**
This command opens the Product Support page in your Web browser. This page is devoted to bringing you useful information for troubleshooting any problems you might be experiencing with ACID.

**ACID Home Page**
This command opens the ACID home page. Here you will find specific news about ACID.

**Send Feedback**
This command sends an email message to feedback@sonicfoundry.com. If you have comments about ACID or any of our products, we want to hear from you.

**Sonic Foundry Home Page**
This command opens the Sonic Foundry home page in your Web browser. All the latest news about Sonic Foundry can be found here.

**Check for New Loops**
This command opens the Sonic Foundry Loop Libraries page in your Web browser. You’ll be able to see a list of available Loop Libraries, listen to samples, and order loops on our secure server.

**About Sonic Foundry ACID**

This command displays ACID version and license information. The Computer tab on the About Sonic Foundry ACID dialog lists the properties of the computer on which ACID is installed.

**Shortcut Menus**

ACID is filled with context-sensitive shortcut menus that display when you right-click almost anywhere in the ACID window.

**Track List Shortcut Menu**

The Track List shortcut menu displays when you right-click on the icon of any Track. The options on this shortcut menu are explained below.

- **Rename**
  This command puts the name of the Track into an editable mode. Renaming a Track does not rename the file associated with that Track. This allows you to give Tracks easy-to-use names if the file name itself is not easy to remember.

- **Use Loop Tempo**
  This command sets the project tempo to the original tempo of the selected Loop.

- **Edit in Audio Editor**
  This command launches the Preferred Audio Editor as specified in Preferences and opens the selected Track. When you are done editing the file, save it and ACID prompts you to reopen the Track. In this way, changes to the file can be updated seamlessly.

- **Delete**
  This command removes the selected Track from the project.
Duplicate Track
This command makes an exact copy of the Track and places it underneath the selected Track. All Events, Envelopes (in ACID Pro and Music only), etc. are copied as well.

Pitch Shift
This command shifts the current pitch of the Track by the specified number of semitones. This pitch shift is in addition to any pitch shifting that is happening as a result of the project key. Pitch-shifting a Track affects all of the Events on that Track.

Color
This option specifies the color of the Track. Tracks can be color coded to indicate logical groupings. For example, all of the drum parts can be yellow and Synth parts can be green.

Properties
This command displays the Track's Properties page at the bottom of the ACID window.

Event Shortcut Menu
The Event shortcut menu displays when you right-click on any Event in the Track View. The options on this shortcut menu are listed below.

Cut
This command clears the Event and places it onto the ACID clipboard so that it can be pasted somewhere else.

Copy
This command makes copy of the Event and places it onto the ACID clipboard so that it can be pasted somewhere else.

Paste
This command pastes the contents of the ACID clipboard into the selected Event at the cursor position.

Delete
This command clears the Event from the Track.
Pitch Shift
This sub-menu contains commands for shifting the pitch of the selected Event. The Event-specific pitch shift is calculated after the project key and the Track's pitch shift.

Up
This command shifts the pitch of the Event up one semitone.

Down
This command shifts the pitch of the Event down one semitone.

Reset
This command removes any pitch shifting that currently exists in the Event.

Envelope
This sub-menu contains commands for toggling Envelopes on and off. The options on this sub-menu are listed below.

Volume
This option toggles the volume Envelope in the Event.

Pan
This option toggles the pan Envelope in the Event.

FX
This option toggles the FX Envelopes in the Event. The number of FX Envelopes is determined by the Number of FX pages to display preference.

Join Events
This command combines all selected Events into one.

Split at Cursor
This command splits the selected Event at the current cursor position.

Properties
This command displays the Event's Properties page at the bottom of the ACID window.
Track Space Shortcut Menu

The Track Space shortcut menu displays when you right-click on a part of a Track that is not occupied by an Event. The options on this shortcut menu are listed below.

Select All on Track
This command selects all of the Events on the Track.

Enable Snap To
This command enables snapping.

Snap To
This option selects the snap resolution.

Save
This command saves the current project.

Save As
This command displays the Save As dialog.

Zoom Normal
This command sets the magnification of the Track View to its default settings.

Zoom Edit
This command sets the track height magnification to its default settings.

Zoom Overview
This command sets the magnification of the Track View so that as much of the project as possible is displayed.
Non-Track Space Shortcut Menu

The Non-Track Space shortcut menu displays when you right-click in the empty space of the Track View that does not contain any Tracks. The options on this shortcut menu are listed below.

- **New**
  This command opens a new, blank ACID project. ACID prompts you to save changes to the current project.

- **Open**
  This command displays the Open File dialog.

- **Record**
  This command displays the Record dialog.

- **Preferences**
  This command displays the Preferences dialog.

Envelope Shortcut Menu

The Envelope shortcut menu displays when you right-click on an Envelope line. The options on this shortcut menu are listed below.

- **Add Point**
  This command adds a new Envelope point at the location where the mouse was clicked.

- **Linear Fade**
  This command makes the current Envelope segment a linear segment.

- **Fast Fade**
  This command makes the current Envelope segment a fast logarithmic segment.

- **Slow Fade**
  This command makes the current Envelope segment a slow logarithmic segment.
Select All
This command selects all of the Envelope points on the Envelope so that you can move them as a group.

Reset All
This command reverts the Envelope back to its default settings.

Volume and FX Envelope Point Shortcut Menu

The Volume and FX Envelope point shortcut menu displays when you right-click on an Envelope point within a volume or FX Envelope. The options on this shortcut menu are listed below.

Note: FX Envelopes are available only in ACID Pro.

Set to 6 dB
This command sets the Envelope point to 6 dB. 6 dB is effectively the top of the Event display and indicates the maximum boost in level by an Envelope.

Set to 0 dB
This command sets the Envelope point to 0 dB. 0 dB indicates no change in level from the Envelope.

Set to –inf dB
This command sets the Envelope point to –inf dB or effectively to the bottom of the Event display.

Delete
This command clears the selected Envelope point.

Linear Fade
This command makes the current Envelope segment a linear segment.
Fast Fade
This command makes the current Envelope segment a fast logarithmic segment.

Slow Fade
This command makes the current Envelope segment a slow logarithmic segment.

Select All
This command selects all of the Envelope points on the Envelope so that you can move them as a group.

Reset All
This command reverts the Envelope back to its default settings.

Pan Envelope Point Shortcut Menu
The Pan Envelope point shortcut menu displays when you right-click on an Envelope point within a pan Envelope.

Set to 100% Left
This command sets the Envelope point all the way to the left.

Set to Center
This command sets the Envelope point to the center.

Set to 100% Right
This command sets the Envelope point all the way to the right.

Delete
This command clears the selected Envelope point.

Linear Fade
This command makes the current Envelope segment a linear segment.

Fast Fade
This command makes the current Envelope segment a fast logarithmic segment.
Slow Fade
This command makes the current Envelope segment a slow logarithmic segment.

Select All
This command selects all of the Envelope points on the Envelope so that you can move them as a group.

Reset All
This command reverts the Envelope back to its default settings.

Loop Region Shortcut Menu
The Loop Region shortcut menu displays when you right-click on the Loop Region. The options on this shortcut menu are listed below.

Play Looped
This option toggles the looped playback mode on and off.

Set Loop to View
This option sets the Loop Region to the visible edges of the Track View. If the entire project is displayed, the Loop Region is set to the ends of the project.

Set Loop to Whole Project
This option sets the Loop Region to the ends of the project.

Mix to New Track
This option mixes all of the audio in un-muted Tracks that are contained within the Loop Region to a new file which is then opened as a new Track.
Loop Region Space Shortcut Menu

The Loop Region Space shortcut menu displays when you right-click on the empty area above the Beat Ruler, but not on the Loop Region itself. The options on this shortcut menu are listed below.

**Drop Marker**
This command adds a new Marker at the cursor position.

**Play Looped**
This option toggles the looped playback mode on and off.

**Set Loop to View**
This option sets the Loop Region to the visible edges of the Track View. If the entire project is displayed the Loop Region is set to the ends of the project.

**Set Loop to Whole Project**
This option sets the Loop Region to the ends of the project.

**Enable Snap To**
This command enables snapping.

**Snap To**
This option selects the snap resolution.

Time Ruler Shortcut Menu

The Time Ruler shortcut menu displays when you right-click on the Time Ruler. For details on the specific formats available, see the Time Ruler Format section on page 83.
Tempo and Key Change Shortcut Menu

The Tempo and Key Change shortcut menu displays when you right-click on a Tempo or Key Change Marker.

**Tempo Change**
This option toggles the tempo change property of the Tempo and Key Change Marker on and off.

**Key Change**
This option toggles the key change property of the Tempo and Key Change Marker on and off.

**Go To**
This command moves the cursor to the Tempo and Key Change Marker position (if there is only one Tempo Change and Key Change Marker. If there is more than one, this option is unavailable.).

**Edit**
This command puts the Tempo and Key Change Marker into an editable mode (if there is only one Tempo Change and Key Change Marker. If there is more than one, this option is unavailable.).

**Delete**
This command clears the Tempo or Key Change Marker on which you clicked.

Tempo and Key Change Space Shortcut Menu

The Tempo and Key Change Space shortcut menu displays when you right-click in the empty space below the Time Ruler but not on a Tempo or Key Change Marker. The options on this shortcut menu are listed below.

**Add Tempo Change**
This command adds a Tempo Change Marker at the mouse position.

**Add Key Change**
This command adds a Key Change Marker at the mouse position.
Add Tempo and Key Change
This command adds a Tempo and Key Change Marker at the mouse position.

Go To
This command moves the cursor to the Tempo and Key Change Marker position.

Edit
This command puts the Tempo and Key Change Marker into an editable mode.

Delete
This command clears the Tempo and Key Change Marker.

Marker Shortcut Menu
The Marker shortcut menu displays when you right-click on a Marker. The options on this shortcut menu are listed below.

Go To
This command moves the cursor to the Marker position.

Rename
This command puts the Marker into an editable mode.

Delete
This command clears the Marker.
Folder Shortcut Menu

The Folder shortcut menu displays when you right-click on a folder in the Media Explorer. The options on this shortcut menu are listed below.

Add as Library Folder
This command creates a Library Folder from the selected folder.

Explore
This command opens a Windows Explorer window of the currently selected folder or the parent folder of the currently selected file in the Media Explorer. This is a useful feature for quickly renaming or deleting files since ACID's Media Explorer can not perform these actions.

Refresh
This command updates the Media Explorer window to show any changes in the drive or folder structure.

Library Folder Shortcut Menu

The Library Folder shortcut menu displays when you right-click on a Library Folder in the Media Explorer. The options on this shortcut menu are listed below.

Remove Library Folder
This command removes the selected Library Folder from the Media Explorer.

Explore
This command opens a Windows Explorer window of the currently selected folder or the parent folder of the currently selected file in the Media Explorer. This is a useful feature for quickly renaming or deleting files since ACID's Media Explorer can not perform these actions.

Refresh
This command updates the Media Explorer window to show any changes in the drive or folder structure.
Meters Shortcut Menu
The Meters shortcut menu displays when you right-click on any of the meters in ACID. The options on this shortcut menu are explained below.

Reset Clip
This command resets the Clip Indication at the top of the meters if it has been lit.

Meter Range
These options select the displayed level range of the meters. Choosing a wide range allows you to see lower level signals at the expense of precision display at high levels.

Show Labels
This option toggles the meter level labels on and off.

Hold Peaks
When this option is selected, the highest peak levels are held on the meter with a thin line.

Hold Valleys
When this option is selected, the lowest peak levels are held on the meter with a thin line.

Keyboard Shortcuts
ACID contains numerous keyboard shortcuts that make editing and navigation faster. These shortcuts are listed below.

General

<table>
<thead>
<tr>
<th>Command</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create new project</td>
<td>Ctrl+N</td>
</tr>
<tr>
<td>Open existing project or file</td>
<td>Ctrl+O</td>
</tr>
<tr>
<td>Save project</td>
<td>Ctrl+S</td>
</tr>
<tr>
<td>Open project's properties</td>
<td>Alt+Enter</td>
</tr>
<tr>
<td>Exit ACID</td>
<td>Alt+F4</td>
</tr>
<tr>
<td>Undo (except in Media Explorer)</td>
<td>Ctrl+Z</td>
</tr>
<tr>
<td>Undo (except in Media Explorer)</td>
<td>Alt+Backspace</td>
</tr>
<tr>
<td>Redo</td>
<td>Ctrl+Shift+Z</td>
</tr>
<tr>
<td>Help Contents and Index</td>
<td>F1</td>
</tr>
<tr>
<td>Enable What's This? help</td>
<td>Shift+F1</td>
</tr>
<tr>
<td>Cancel operation</td>
<td>Esc</td>
</tr>
<tr>
<td>Display shortcut menu for whatever has focus</td>
<td>Shift+F10</td>
</tr>
</tbody>
</table>
## Track View

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record</td>
<td>Ctrl+R</td>
</tr>
<tr>
<td>Go to</td>
<td>Ctrl+G</td>
</tr>
<tr>
<td>Mix to new (ACID Pro only)</td>
<td>Ctrl+M</td>
</tr>
<tr>
<td>Select all Events</td>
<td>Ctrl+A</td>
</tr>
<tr>
<td>Unselect all Events</td>
<td>Ctrl+Shift+A</td>
</tr>
<tr>
<td>Drop Marker</td>
<td>M</td>
</tr>
<tr>
<td>Add tempo change</td>
<td>T</td>
</tr>
<tr>
<td>Add key change</td>
<td>K</td>
</tr>
<tr>
<td>Add tempo and key change</td>
<td>Shift+T</td>
</tr>
<tr>
<td>Shift focus between Track List and Track View Tab</td>
<td></td>
</tr>
<tr>
<td>Set start of Loop Region to cursor position</td>
<td>I</td>
</tr>
<tr>
<td>Set end of Loop Region to cursor position if later than start, otherwise set start of Loop Region</td>
<td>O</td>
</tr>
<tr>
<td>Set Loop Region to the size of the Track View. Pressing again toggles back to original position.</td>
<td>Ctrl+L</td>
</tr>
<tr>
<td>Set Loop Region to the entire project. Pressing again toggles back to original position.</td>
<td>Shift+L</td>
</tr>
</tbody>
</table>
## Track List

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pitch down 1 semitone</td>
<td>Numpad -</td>
</tr>
<tr>
<td>Pitch up 1 semitone</td>
<td>Numpad +</td>
</tr>
<tr>
<td>Pitch down 1 octave</td>
<td>Ctrl+Numpad -</td>
</tr>
<tr>
<td>Pitch up 1 octave</td>
<td>Ctrl+Numpad +</td>
</tr>
<tr>
<td>Pitch down 4 semitones (Windows NT only)</td>
<td>Shift+Numpad -</td>
</tr>
<tr>
<td>Pitch up 4 semitones (Windows NT only)</td>
<td>Shift+Numpad +</td>
</tr>
<tr>
<td>Reset pitch</td>
<td>Numpad *</td>
</tr>
<tr>
<td>Decrease fader value</td>
<td>Left arrow</td>
</tr>
<tr>
<td>Increase fader value</td>
<td>Right arrow</td>
</tr>
<tr>
<td>Move Track selection up one Track</td>
<td>Up arrow</td>
</tr>
<tr>
<td>Move Track selection down one Track</td>
<td>Down arrow</td>
</tr>
<tr>
<td>Multi-select Tracks</td>
<td>Shift+Up or Down arrow</td>
</tr>
<tr>
<td>Move Track selection up one “page” of Tracks</td>
<td>Page Up</td>
</tr>
<tr>
<td>Move Track selection down one “page” of Tracks</td>
<td>Page Down</td>
</tr>
<tr>
<td>Select all Tracks</td>
<td>Ctrl+A</td>
</tr>
<tr>
<td>Unselect all Tracks</td>
<td>Ctrl+Shift+A</td>
</tr>
<tr>
<td>Delete Track</td>
<td>Delete</td>
</tr>
<tr>
<td>Edit Track name</td>
<td>F2</td>
</tr>
</tbody>
</table>
### Event Editing

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut</td>
<td>Ctrl+X</td>
</tr>
<tr>
<td>Cut</td>
<td>Shift+Delete</td>
</tr>
<tr>
<td>Copy</td>
<td>Ctrl+C</td>
</tr>
<tr>
<td>Copy</td>
<td>Ctrl+Insert</td>
</tr>
<tr>
<td>Paste</td>
<td>Ctrl+V</td>
</tr>
<tr>
<td>Paste</td>
<td>Shift+Insert</td>
</tr>
<tr>
<td>Paste Insert</td>
<td>Ctrl+Shift+V</td>
</tr>
<tr>
<td>Delete Events</td>
<td>Delete</td>
</tr>
<tr>
<td>Cycle through edit tools</td>
<td>D</td>
</tr>
<tr>
<td>Cycle backward through edit tools</td>
<td>Shift+D</td>
</tr>
<tr>
<td>Select Draw tool</td>
<td>Ctrl+D</td>
</tr>
<tr>
<td>Join selected Events</td>
<td>J</td>
</tr>
<tr>
<td>Split Event at cursor</td>
<td>S</td>
</tr>
<tr>
<td>Add or remove Volume Envelope</td>
<td>V</td>
</tr>
<tr>
<td>Add or remove Pan Envelope</td>
<td>P</td>
</tr>
<tr>
<td>Add or remove FX 1 Envelope</td>
<td>F</td>
</tr>
<tr>
<td>Add or remove FX 2 Envelope</td>
<td>G</td>
</tr>
<tr>
<td>Pitch down 1 semitone</td>
<td>Numpad -</td>
</tr>
<tr>
<td>Pitch up 1 semitone</td>
<td>Numpad +</td>
</tr>
<tr>
<td>Pitch down 1 octave</td>
<td>Ctrl+ Numpad -</td>
</tr>
<tr>
<td>Pitch up 1 octave</td>
<td>Ctrl+ Numpad +</td>
</tr>
<tr>
<td>Pitch down 4 semitones (Windows NT only)</td>
<td>Shift+Numpad -</td>
</tr>
<tr>
<td>Pitch up 4 semitones (Windows NT only)</td>
<td>Shift+Numpad +</td>
</tr>
<tr>
<td>Reset pitch</td>
<td>Numpad *</td>
</tr>
<tr>
<td>Temporarily disable Snap To</td>
<td>Shift while dragging Event</td>
</tr>
<tr>
<td>Display Properties page for Event</td>
<td>F2</td>
</tr>
</tbody>
</table>

### Playback

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Play/Stop with focus in Track View</td>
<td>Spacebar</td>
</tr>
<tr>
<td>Play All/Pause with focus in Track View</td>
<td>Shift+Spacebar</td>
</tr>
<tr>
<td>Play/Stop with focus anywhere</td>
<td>Ctrl+P</td>
</tr>
<tr>
<td>Play/Stop with focus anywhere</td>
<td>Ctrl+Spacebar</td>
</tr>
<tr>
<td>Play All with focus anywhere</td>
<td>Ctrl+Shift+Spacebar</td>
</tr>
<tr>
<td>Pause</td>
<td>Enter</td>
</tr>
<tr>
<td>Pause with focus anywhere</td>
<td>Ctrl+Enter</td>
</tr>
<tr>
<td>Play Looped on/off</td>
<td>L</td>
</tr>
</tbody>
</table>
**Navigation**

If Loop Region is active:

<table>
<thead>
<tr>
<th>Move cursor to start of Loop Region</th>
<th>Home</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move cursor to end of Loop Region</td>
<td>End</td>
</tr>
<tr>
<td>Move cursor to start of Loop Region</td>
<td>W</td>
</tr>
<tr>
<td>Move cursor to end of Loop Region</td>
<td>E</td>
</tr>
<tr>
<td>Move cursor to start of project</td>
<td>Ctrl+Home</td>
</tr>
<tr>
<td>Move cursor to end of project</td>
<td>Ctrl+End</td>
</tr>
<tr>
<td>Move cursor to start of project</td>
<td>Home</td>
</tr>
<tr>
<td>Move cursor to end of project</td>
<td>End</td>
</tr>
<tr>
<td>Move cursor to start of project</td>
<td>W</td>
</tr>
<tr>
<td>Move cursor to end of project</td>
<td>E</td>
</tr>
<tr>
<td>Move cursor 1 pixel</td>
<td>Left or Right Arrow</td>
</tr>
</tbody>
</table>

Move cursor to next or previous Marker. If no Markers exist, go to start or end of project. Ctrl+Left or Right Arrow

When Snap To is disabled:

<table>
<thead>
<tr>
<th>Move cursor by small increments</th>
<th>Page Up or Page Down</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move cursor by large increments</td>
<td>Ctrl+Page Up or Page Down</td>
</tr>
<tr>
<td>Move cursor by Beat Ruler markings</td>
<td>Page Up or Page Down</td>
</tr>
<tr>
<td>Move cursor by 4 Beat Ruler markings</td>
<td>Ctrl+Page Up or Page Down</td>
</tr>
<tr>
<td>Move cursor to corresponding Marker</td>
<td>Number keys (not Numpad)</td>
</tr>
</tbody>
</table>
Magnification and View

<table>
<thead>
<tr>
<th>Feature</th>
<th>Key(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom time in/out small increments</td>
<td>Up or Down Arrow</td>
</tr>
<tr>
<td>Zoom time in/out large increments</td>
<td>Ctrl+Up or Down Arrow</td>
</tr>
<tr>
<td>Zoom Track height in/out small increments</td>
<td>Shift+Up or Down Arrow</td>
</tr>
<tr>
<td>Zoom Track height in/out large increments</td>
<td>Ctrl+Shift+Up or Down Arrow</td>
</tr>
<tr>
<td>Zoom normal</td>
<td>F9</td>
</tr>
<tr>
<td>Zoom edit</td>
<td>Shift+F9</td>
</tr>
<tr>
<td>Zoom overview</td>
<td>Ctrl+F9</td>
</tr>
<tr>
<td>Zoom in full</td>
<td>Ctrl+Shift+F9</td>
</tr>
<tr>
<td>Switch focus through all parts of ACID window</td>
<td>F6</td>
</tr>
<tr>
<td>Switch focus backwards through all parts of ACID window</td>
<td>Shift+F6</td>
</tr>
<tr>
<td>Cycle through Explorer, Properties, Mixer and FX pages</td>
<td>Ctrl+Tab</td>
</tr>
<tr>
<td>Cycle backward through Explorer, Properties, Mixer and FX pages</td>
<td>Ctrl+Shift+Tab</td>
</tr>
<tr>
<td>Center cursor in Track View</td>
<td>C</td>
</tr>
<tr>
<td>Focus to Track View</td>
<td>Ctrl+T</td>
</tr>
<tr>
<td>Focus to Track View</td>
<td>Alt+0</td>
</tr>
<tr>
<td>Display Media Explorer page</td>
<td>Alt+1</td>
</tr>
<tr>
<td>Display Properties page</td>
<td>Alt+2</td>
</tr>
<tr>
<td>Display Mixer page</td>
<td>Alt+3</td>
</tr>
<tr>
<td>Display FX1 page</td>
<td>Alt+4</td>
</tr>
<tr>
<td>Display FX 2 page</td>
<td>Alt+5</td>
</tr>
<tr>
<td>Display FX 3 page</td>
<td>Alt+6</td>
</tr>
<tr>
<td>Display FX 4 page</td>
<td>Alt+7</td>
</tr>
<tr>
<td>Display FX 5 page</td>
<td>Alt+8</td>
</tr>
<tr>
<td>Display FX 6 page</td>
<td>Alt+9</td>
</tr>
</tbody>
</table>

Miscellaneous

<table>
<thead>
<tr>
<th>Feature</th>
<th>Key(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generate MIDI Time Code</td>
<td>F7</td>
</tr>
<tr>
<td>Generate MIDI Clock</td>
<td>Shift+F7</td>
</tr>
<tr>
<td>Chase to MIDI Time Code</td>
<td>Ctrl+F7</td>
</tr>
<tr>
<td>Enable or disable Snap To</td>
<td>F8</td>
</tr>
<tr>
<td>Explore current folder (in Media Explorer)</td>
<td>Ctrl+E</td>
</tr>
</tbody>
</table>
Why do my own Loops sometimes play a lot faster or slower than I intended?

When a loop is not “ACIDized,” ACID has to make logical guesses about the tempo of a file. On rare occasions, it will guess incorrectly. Usually, if it does guess incorrectly, it will guess that there are half as many beats in the file as there really are. This kind of error causes the loop to play twice as fast as it should.

To remedy this problem, do the following:

1. Click the Properties tab at the bottom of the main ACID window. The Properties page displays.
2. Click the Track tab in the Properties page.
3. Increase or decrease the Number of beats control (usually by a factor of 2) until the Loop plays at the correct tempo.

Note: Disk-based Tracks can also exhibit this behavior. Adjust the Stretch from tempo control on the Track tab to indicate the correct original tempo of the file. This control is only available if you have selected Disk-Based in the Track Type field.
Why do some of my Loops sound like they have been put through an echo effect?

There are two possibilities for this condition:

1. You may be trying to slow down the tempo of a fast Loop too much, or

2. For Pro users only: You have not adjusted the Stretch Properties of the Loop.

ACID is very good at time-compressing and expanding files, however, it can't work magic. A 140 bpm Loop is not going to sound very good at 90 bpm. Extreme slow-downs in tempo can create echo artifacts.

If you are using ACID Pro, you can try the following solutions:

Adjusting the Stretch Properties of a Loop can help to minimize these artifacts. To adjust the Stretch Properties, follow these steps:

1. Select a Track or Event.

2. Click the Properties tab at the bottom of the main ACID window. The Properties page displays.

3. Click the Stretch tab in the Properties page.

The rule of thumb is that a Marker should be on each pronounced beat or transient attack in the file. The more accurately the Markers track the transients in the file, the better the time compress and expand will sound.

Another solution to this problem is to select the Pitch shift segments option in the Stretching method field. This option shifts the pitch of the track to allow for extreme tempo changes.

Why can’t I hear any of my DirectX plug-ins when I open them?

Hearing the results of a DirectX plug-in that has been chosen from the FX page is a two step process:

1. Send the FX level from the Track on which you wish to put the effect. This is accomplished by switching the multi-purpose fader on the Track (located next to the Track icon on the Track List) to FX and raising the level. You should now see the level on the meters in the FX page at the bottom of your main ACID window. Adjust the fader until the level on the meters is where you want it.

2. Choose an output device for the effect. The Device Selection button (the one with the number on it) in the FX page allows you to select a playback device to send the effect to. The output level of the effect is controlled by the plug-in you are using. If the plug-in does not have a master output, you will have to control the level of the effect from its Input faders.
How do I use a DirectX plug-in as an “insert” effect?

All plug-ins are pre-fader in ACID. This means that the master level for the Track will not affect the level going to any of the plug-ins.

To set up a plug-in such as a compressor or equalizer as an insert, you will have use the FX send level from the Track as the master Volume fader. This is accomplished by turning the Volume fader on the Track List all the way down to –Inf.

The FX fader will now control the level going into the plug-in, as well as the total level that you hear of the Track. This is because the output of the plug-in is the only output of the Track that you will hear.

Why does my ACID project skip or gap during playback?

Several things can cause skipping and gapping in the audio during playback. The most common cause is a lack of RAM. Most of the audio that you deal with in ACID will be stored in RAM. If you open a lot of files, RAM can be eaten up quickly. If too much of your physical RAM is being used, Windows will start “swapping” out RAM to your hard drive. If this happens to your Loops, ACID will most likely gap when it has to swap the audio back into RAM.

There is a handy RAM usage meter at the bottom of the ACID window. If the meter ever reaches the red stage, you might experience audio gapping.

Another reason for audio gapping might be that you are playing too many Disk-Based Tracks at once. ACID is not optimized to play more than one or two stretched Disk-Based Tracks at a time. Unstretched Disk-Based Tracks will perform better, but will still top out at four or five, depending on your system configuration.

ACID will also need a pretty fast CPU in order to play projects with large combinations of Envelopes (available only in ACID Pro and Music), plug-ins (available only in ACID Pro and Music) and Tracks. If your CPU can’t keep up with all of the processing that is happening in real-time, you will have to cut back on the amount of real-time processing or upgrade your CPU.

This problem can also be caused by issues with your sound card drivers. Check with the manufacturer of your sound card to find out if updates are available for your drivers.

Why does Cakewalk Pro Audio drop out of MIDI Clock sync when I move the play cursor around in ACID?

This is due to a known bug in Cakewalk Pro Audio.
FREQUENTLY ASKED QUESTIONS

CHP. 5

Why does ACID sometimes lose sync when it is chasing to MIDI Time Code?

When ACID is chasing to MIDI Time Code, it is very vulnerable to system slow-downs. Anything that might take processor time away from ACID may cause it to lose sync.

To minimize the risks, try the following:

1. Only run the applications that are synching at the same time. Close any other background applications. This includes applications like Microsoft Find Fast and System Agent that might be running without your knowledge.

2. Make sure that ACID is not low on RAM. Check the RAM usage indicator at the bottom of the ACID window. It should be running in the green to sync reliably.

3. If you are using multiple sound cards, make sure that there are absolutely no conflicts between them. Any time one of the sound cards causes the other card to gap a little, sync is thrown off.

How can I save each of my Tracks in ACID so that I can use them in another application?

You can use the Export command on the File menu to save out your Tracks as separate files. From the Export type drop-down list, choose Save each Track as a separate file. Each Track in the project that is not muted is saved in the specified format as a separate file. These files can then be opened in other applications.

ACID’s time compression is very good; how can I use it to just stretch my loops so I can use them in another application?

You can use the Export command in the File menu to save out any opened Loops at the current project tempo. From the Export type drop-down list, choose Save Loop files at project tempo. Each Loop file that is open in the project is saved as a new file that has been stretched to the project tempo. If there are tempo changes in the project, ACID saves out copies at each tempo.

Note: This action does not save out the whole Track as a separate file, it will only save the Loop file. Use the Export type Save each Track as a separate file for saving out entire Tracks.
Why do I sometimes get a crash error when I start ACID?

If you have the VivoActive Audio Decompressor installed (installed with Microsoft Windows Media) it is possible that the crash is happening when ACID looks through the list of installed DirectX plug-ins. This particular plug-in will crash when it is queried in such a way. ACID should continue to function normally after the crash; however, you may want to restart your computer before proceeding. This crash will not happen again until you install or uninstall a DirectX plug-in.

How do I make a Loop from the audio that I just recorded?

The recording that you make is recorded as a single Track, which you can edit to include only the take you wish to keep, using the Loop Region and the Mix to New Track command on the Edit menu.

To accomplish this, follow these steps:
1. Solo the new Track by clicking once on the Track’s Solo button ( ).
2. Position the Loop Region around the take you wish to keep.
3. From the Edit menu, choose Mix to New Track. The contents of the Loop Region are saved to a new file and a new Loop Track is created.

If you are going to use this method of creating Loops, it is recommended that you record without the Make new Track follow project tempo option enabled on the Record dialog. This preserves the quality of the recorded audio and makes the time stretching sound better.

What CD-R/CD-RW media do you recommend for use with ACID?

The media you use with ACID should be the media that your CD-R or CD-RW manufacturer recommends for use with their drive.
How can I use sample rates other than 44.1 kHz when burning a CD using ACID?

Red Book calls for 44.1 kHz as the sample rate on audio CDs. If you intend to use ACID to master CDs, you must use a sample rate of 44.1 kHz when you write to the CD. You can, however, change your playback and record sample rate in the Preferences Audio tab. To accomplish this, follow these steps:

1. From the Options menu, choose Preferences. The Preferences dialog displays.
2. Click the Audio tab. The Audio page displays.
3. In the Playback and record sample rate field, select the desired rate.
4. Click the OK button to save your selection and exit the Preferences dialog.

Note: You will not be able to burn a CD at any rate other than 44.1 kHz.

Why do I get buffer underruns when writing a CD using ACID?

A buffer underrun is caused when data cannot be transferred to your CD recorder fast enough, due to a slower computer. ACID can remedy this problem by rendering your current project to a temporary .wav file on your hard drive before writing the song to your CD. To accomplish this, follow these steps:

1. From the Options menu, choose Preferences. The Preferences dialog displays.
2. Click the Create CD tab. The Create CD page displays.
3. Select the Use temporary hard disk file when creating CD check box to turn this option on.

Note: The Use temporary hard disk file when creating CD check box is turned off (unselected) by default.

4. Click the OK button to save your selection and exit the Preferences dialog.
Index

A
- Accessing frequently-used folders, 31
- ACID
  - Starting, 9
- ACID project
  - Burning to a CD, 61
- ACIDizing
  - Files, 27, 50
  - Loops, 27
- ACIDizing files, 115
- ACIDPlanet, 70
- Activation number, 11
- Adding effects, 47
- Adding Markers, 57
- Adding Tracks to a CD, 61
- Adjusting
  - FX, 41
  - Pan, 41
  - Volume, 41
- Adjusting latency, 49
- Audio
  - Exporting, 69
  - Monitoring, 46

B
- Buffer underruns, 120
- Burning songs to a CD, 61

C
- CD creation, 61
  - Adding Tracks, 61
  - Closing the disc, 63
- Changing
  - Key, 37
  - Tempo, 37
- Changing Key, 58
- Changing snaps, 58
- Changing Tempo, 23, 58
- Channels, 45
- Chasing MIDI Time Code, 60
- Clipping, 46
- Closing the disc, 63
- Configuring ACID, 86
- Configuring the Virtual MIDI Router (VMR), 18
- Contacting Technical Support, 15
- Copying Events, 38
- Create CD menu, 81
- Creating a CD, 61
- Cutting Events, 38
INDEX

D
Deleting Markers, 57
Desktop shortcut, 10
DirectX plug-ins, 47, 116, 117

E
Edit menu, 72
Editing, 33
Advanced, 54
FX envelopes, 54
Pan envelopes, 54
Using envelopes, 54
Volume envelopes, 54
Editing Events, 38
Effect
Assigning Tracks to, 47
Routing Tracks to, 47
Effects
Adding, 47
Adjusting latency, 49
Moving property pages, 49
Saving presets, 49
Selecting, 47
Tearing off property pages, 49
Email technical support, 15
Envelope Tool, 55
Envelopes, 54
Erase Tool, 55
European contact information
Events
Adding, 23
Adding to Track, 35
Changing the length, 38
Copying, 38
Cutting, 38
Deleting, 38
Editing, 38
Modifying properties, 53
Moving, 38
Pasting, 38
Setting properties, 50
Explorer, 21, 30
Creating libraries, 31
Exporting audio, 69
Exporting files, 118
ExpressFX plug-ins, 47, 116, 117

F
Fax technical support, 15
File menu, 65
Files
ACIDizing, 50, 115
Exporting, 118
Opening, 65
Saving, 67
FX, 27
Adjusting, 41

G
Generating MIDI Clock, 61
Generating MIDI Time Code, 59

H
Help menu, 94

I
Installation, 9
Installing the Virtual MIDI Router (VMR), 16

K
Key
Changing, 37, 58
Control, 37

L
Latency, 49
Libraries
Creating, 31
Loop
  Stretch Properties, 116
Loop Region, 36
Loops, 26
  ACIDizing, 27, 115
  Adding, 21
  Arranging, 23
  Creating, 119
  Previewing, 32

M
  Markers, 57
    Key Change, 58
    Tempo Change, 58
  Media Explorer, 21, 27, 30
    Creating libraries, 31
    Navigating, 30
  MIDI Clock, 59
    Generating, 61
  MIDI Time Code, 59
    Chasing, 60
    Chasing to, 118
    Generating, 59
  Mix
    Adjusting, 41
  Mixer, 27
  Mixing to new Track, 119
  Modifying Event properties, 53
  Modifying stretching properties, 51
  Modifying Track properties, 51
  Monitoring audio, 46
  Monitoring recording levels, 46
  MTC, 59
  Multi-function section
    Explorer, 27
    FX, 27
    Mixer, 27
    Properties, 27
    Muting a Track, 42

N
  Numbers
    Activation, 11
    Serial, 11

O
  Online help, 13
    Accessing, 13
    Via the web, 14
    What's This? help, 14
  Online registration, 12
  Opening files, 65
  Options menu, 82

P
  Paint Tool, 55
  Pan
    Adjusting, 41
  Pasting Events, 38
  Playback, 35
    Devices, 42
    Gapping, 117
    Looped, 36
    Skipping, 117
  Playing
    A project, 23
    Tracks, 23
  Presets, 49
  Previewing loops, 32
  Properties, 27
  Publishing to ACIDPlanet, 70

R
  Recording, 43
    Attributes, 45
    Channels, 45
    Monitoring levels, 46
    Sample rate, 45
    Sample size, 45
Registering ACID
   Online, 12
   Telephone, 13
Renaming Markers, 57
Reordering Tracks, 43

Sample rate, 45
Sample rates, 120
Sample size, 45
Saving effects presets, 49
Saving files, 67
Select Tool, 56
Selecting Effects, 47
Serial Number, 11
   Title page
Setting Event properties, 50
Setting system preferences, 86
Setting Track properties, 50
Shortcut
   Starting from, 10
Shortcuts
   Keyboard, 109
   Menus, 97
Snapping
   Changing, 58
Soloing a Track, 42
Sonic Foundry Virtual MIDI Router (VMR), 16
Starting ACID, 9
Stretch Properties, 116
 Stretching properties, modifying, 51
Synchronization
   Time Code, 59
System Requirements, 8

T
   Technical Support, 15
   Technical support
      E-mail, 15
      Fax, 15
      Telephone number, 15
      Web site, 15
   Technical support Title page
   Telephone registration, 13
   Tempo
      Changing, 23, 37, 58
      Slider, 37
   Tempo and Key Changes, 58
   Time Code Synchronization, 59
   Toolbar, 28
      Customizing, 29, 85
   Tools
      Envelope, 55
      Erase, 55
      Paint, 55
      Select, 56
      Zoom, 56
   Track List, 27
      Editing in, 40
   Track View, 27
      Arranging loops, 23
      Editing, 33
Tracks
  Adding, 21
  Adding Events, 35
  Advanced editing, 54
  Disk-Based, 26
  Loops, 26
  Mixing to new, 119
  Modifying properties, 51
  Muting, 42
  One-Shots, 26
  Playing, 23
  Reordering, 43
  Setting properties, 50
  Soloing, 42
  Types, 26

Troubleshooting
  Buffer underruns, 120
  Can’t hear DirectX plug-ins, 116
  CD-R/CD-RW media, 119
  Chasing to MIDI Time Code, 118
  Crash error upon start-up, 119
  Creating loops from recorded audio, 119
  Echo effect, 116
  Loops playing too fast, 115
  Loops playing too slow, 115
  Playback skipping or gapping, 117
  Sample rates, 120
  Saving Tracks for use in other applications, 118
  Stretching loops, 118
  Using DirectX plug-in as an insert effect, 117
  Writing to CD, 120

Tutorial, 25

U
  US contact information Title page
  Using Markers, 57

V
  View menu, 79
  Virtual MIDI Router, 16
    Configuring, 18
    Installing, 16
  VMR, 16
    Configuring, 18
    Installing, 16
  Volume
    Adjusting, 41
  What’s This! Help
    Using, 27
  What’s This! help, Using, 14
  Writing to CD
    Sample rates, 120
  Zoom Tool, 56